
 

  

 

 

CM&I GATEWAY - PROTOCOL TRANSLATOR SOFTWARE 

 

 

 

 

 
CM&I Gateway 

 
Multi-protocols Communications Module 

 

 

 

 

 

 

User  Manual 

 

 

 

 

 

00015-02 Revision B 

May, 2008 

 

 

 

 

 
Ruhcon Inc. Consulting 

27665 W. Wilmot Rd. Antioch, IL 60002 
Phone: (+1) 847-838-9286 

 

 



 

 

    

iiii              00015-02 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

Copyright 2008© 

Ruhcon Inc. 

All rights reserved. 

 

 

No part of this documentation may be reproduced, du plicated, distributed or modified without the expres s written permission 

of Ruhcon Inc. 



    

00015-02         iii   

 

 

 

NOTE 
 

 

 

 
CM&I Suite© and CM&I Gateway© are trademarks of  

GA Produtos e Soluções para Automação Predial Ltda. and Ruhcon Inc. 

 

 

 

All other trademarks and products are registered trademarks of their respective owners and/or 
companies. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Due to continuing development of Ruhcon Inc. products, the information on this document is 
subject to changes and/or modifications without previous notice. Ruhcon Inc. is not responsible 

for typographical errors or misinterpretation of the information on this document and/or for 
damages and losses caused to third parties. The content of this publication might be modified at 

any time without any obligation to notify any part involved. This shall not cause, under any 
circumstances, any warranty change, complaint or extension. 

 

 

 



 

 

    

iivv              00015-02 

 
 
 



    

00015-02         v   

 

 

SSuummmmaarryy  

 

1. INTRODUCTION ....................................................................................................................... 1�

1.1� DESCRIPTION .................................................................................................................... 1�
1.2� TERMS AND CONDITIONS ................................................................................................... 2�
1.3� DOCUMENTATION .............................................................................................................. 2�
1.4� PROCESSING ENVIRONMENT .............................................................................................. 2�

2.� CM&I GATEWAY COMPONENTS ........................... .............................................................. 3�

2.1� LIBRARIES AND APPLICATIONS ........................................................................................... 3�
2.2� DIRECTORY STRUCTURE ................................................................................................... 4�

2.2.1 GATEWAY SERVER MODULE ...................................................................................................................... 4�

2.2.2 GATEWAY CLIENT MODULE ........................................................................................................................ 4�
2.3� A CM&I GATEWAY PROJECT ............................................................................................. 4�

2.3.1 PARAMETERS AND OPTIONS ...................................................................................................................... 4�

2.3.2 PROJECT OBJECTS ...................................................................................................................................... 4�
2.4� DATABASE ........................................................................................................................ 5�

2.4.1 “CANAISPEC” TABLE..................................................................................................................................... 5�

2.4.2 “MODULOSCOMM” TABLE ............................................................................................................................ 5�

2.4.3 “TIPOPONTOS” TABLE .................................................................................................................................. 6�

2.4.4 UDL FILE ........................................................................................................................................................ 6�

3.� STARTING CM&I GATEWAY ............................. ................................................................... 9�

3.1� GATEWAY SERVER MODULE .............................................................................................. 9�

3.1.1 CM&I GATEWAY INTERFACE ....................................................................................................................... 9�

3.1.2 GATEWAY RUNTIME ................................................................................................................................... 10�

3.1.3 DBCREATOR ............................................................................................................................................... 11�
3.2� GATEWAY CLIENT MODULE .............................................................................................. 12�
3.3� SOFTWARE PROTECTION ................................................................................................. 13�

3.3.1 FORMS OF PROTECTION ........................................................................................................................... 13�

3.3.2 RUNNING IN THE DEMONSTRATION MODE ............................................................................................ 13�

3.3.3 RUNNING AUTHORIZATION ....................................................................................................................... 14�

3.3.4 LICENSE TRANSFER .................................................................................................................................. 14�

4.� CM&I GATEWAY SERVER ............................... .................................................................. 15�

4.1� UTILITIES ........................................................................................................................ 15�

4.1.1 DATABASE CREATOR ................................................................................................................................ 15�

4.1.2 EXPORT POINT LIST ................................................................................................................................... 17�

4.1.3 GATEWAY VIEWER ..................................................................................................................................... 17�

4.1.4 GATEWAY RUNTIME (SPPCOMGTW.EXE) ............................................................................................... 44�



 

 

    

vvii              00015-02 

4.1.5 EVENT VIEWER ........................................................................................................................................... 54�
4.2� CONFIGURATIONS ........................................................................................................... 55�
4.3� GATEWAY RESTORE ........................................................................................................ 56�

4.3.1 CREATING A RESTORATION POINT ......................................................................................................... 56�

4.3.2 RESTORING A PROJECT IMAGE ............................................................................................................... 57�

5.� CM&I GATEWAY CLIENT ............................... .................................................................... 59�

6.� COMMUNICATION PROTOCOLS ........................... ............................................................ 62�

6.1� DETECTOMAT ............................................................................................................. 62�

6.1.1 MODULE ACRONYM ................................................................................................................................... 62�

6.1.2 POINT TYPE ................................................................................................................................................. 62�

6.1.3 POINT ADDRESSING ON CANAISPEC TABLE .......................................................................................... 62�

6.1.4 DETECTOMAT CHANNEL CONFIGURATION ............................................................................................ 68�

6.1.5 DETECTOMAT DEVICES CONFIGURATION .............................................................................................. 69�
6.2� MODBUS ...................................................................................................................... 71�

6.2.1 MODULE ACRONYM ................................................................................................................................... 71�

6.2.2 POINT TYPE ................................................................................................................................................. 72�

6.2.3 POINT TYPE CHARACTERISTICS .............................................................................................................. 72�

6.2.4 POINT ADDRESSING ON CANAISPEC TABLE .......................................................................................... 74�

6.2.5 CONFIGURING A SPECIFIC MODBUS CHANNEL TAB ............................................................................. 78�

6.2.6 CONFIGURING A MODBUS IED ................................................................................................................. 80�
6.3 OPC ................................................................................................................................... 81�

6.3.1 OPC - OLE FOR PROCESS CONTROL - OPC SERVER ............................................................................ 81�

6.3.2 OPC READINGS .......................................................................................................................................... 83�

6.3.3 OPC WRITING .............................................................................................................................................. 83�

6.3.4 OPC SERVER REGISTRATION FILE .......................................................................................................... 83�
6.4� BACNET (MS/TP OR IP) .................................................................................................. 84�

6.4.1 MODULE CODE ........................................................................................................................................... 84�

6.4.2 TYPES OF POINTS ...................................................................................................................................... 84�

6.4.3 ACRONYMS DESCRIPTION ........................................................................................................................ 85�

6.4.4 POINT ADDRESSING .................................................................................................................................. 85�

6.4.5 BACNET CHANNEL PARAMETERS CONFIGURATION ............................................................................. 87�

6.4.6 BACNET IED CONFIGURATION.................................................................................................................. 89�

6.4.7 PRIORITIES ARRAY .................................................................................................................................... 91�

6.4.8 SENDING COMMANDS ............................................................................................................................... 93�



Introduction 

 00015-02           1 

11..  IInntt rroodduucctt iioonn  

11..11  DDeessccrr iipptt iioonn  
The CM&I Gateway is a multi-protocol communications processor designed to connect IED's 
(Intelligent Electronic Devices) and clients using different protocols.  

Installed on an embedded computer, the CM&I Gateway establishes channels, or logical 
communication paths, to transfer data using equipment and/or applications. The current version 
of CM&I Gateway supports the translation of DETECTOMAT, MODBUS, and BACnet MS/TP 
protocols for the MODBUS, OPC, and BACnet MS/TP protocols, as shown in the figure below.  

The CM&I Gateway supports multiple communications channels simultaneously, both client 
protocols and server protocols. This allows the use of the CM&I Gateway as an IED concentrator, 
gathering data from different pieces of equipment in a single data point. As well as this, this 
feature allows the data read from the IED's to be sent to multiple clients over different protocols, 
as shown in the figure below. 

 
Figure 1 - Protocols supported by CM&I Gateway. 
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11..22  TTeerrmmss  aanndd  CCoonnddii tt iioonnss  
CM&I Gateway is property of Ruhcon Inc., who is the copyright owner of this product. 

The system shall only be used by user license purchasers and its reproduction by any means, as 
well as its use in a greater number than the original number of computer licenses purchased is 
not permitted. 

11..33  DDooccuummeennttaatt iioonn  
This documentation is supplied for exclusive use of the CM&I Gateway license purchasers, and 
its reproduction by any means, including by electronic means, without previous authorization of 
Ruhcon Inc. is not permitted. 

11..44  PPrroocceessssiinngg  EEnnvvii rroonnmmeenntt   
The CM&I Gateway software runs on the following operating systems: MS Windows 2000, MS 
Windows Server 2003, MS Windows XP Professional, and MS Vista. Hardware requirements: 
Intel standard processor, 1GB RAM, minimum 50MB of available hard disk space for the software 
and database. Serial communication ports and/or Ethernet 10/100 Mbps Interfaces are also 
required, according to the number and type of communication channels. 
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22..  CCMM&&II  GGaatteewwaayy  CCoommppoonneennttss  

22..11  LLiibbrraarr iieess  aanndd  AAppppll iiccaatt iioonnss  
The CM&I Gateway has two modules: Gateway Server and Gateway Client. 

The Gateway Server is installed in an embedded PC or regular desktop computer, henceforth 
denominated Gateway-PC, and it includes the protocol translation and the communication 
software, the project parameterization application, the Detectomat project database generation 
software, and other application configuration and project maintenance tools. 

The Gateway Client is used to establish a connection between any computer and the Gateway-
PC. This module is to be installed in the client computer, allowing access to the Gateway Server 
interface. 

The applications and libraries which are part of the CM&I Gateway are described below: 

GTWSERVER.EXE - Application responsible for the Gateway Server. This program 
features a set of menus to navigate the project configuration and application options, 
as well as allowing access to the application which sets the parameters of the project 
(SPINGATE.EXE), and to the Detectomat project database generation program 
(DBCREATOR.EXE). 

GTWVIEWER.EXE - Application responsible for the Gateway Client. This program 
creates a current Gateway-PC status indicator on the client computer, and the menu 
used to establish a connection between the computer and the Gateway-PC.  

SPPCOMGTW.EXE - Runtime Program responsible for reading the points schedule and 
for the database creation in real time. Once the database is created, the 
communication channels are opened in accordance with the parameters in the project 
file, and the communication starts, using specific protocols for each channel. 

SPINGATE.EXE - Application responsible for the CM&I Gateway Interface. This program 
allows the setting of the parameters of a project with definition of communication channel 
characteristics, protocols, equipment and input and output points, by equipment. It also has 
a real time viewing interface for the input data, command line control, events viewing and            
control of starting and ending the Gateway runtime (Sppcomgtw.exe) program. 

DBCREATOR.EXE - Application used to generate the project database for the Detectomat 
fire alarm control panels. This tool was developed to make the database creation process 
easier. The user only has to inform the project parameters, such as panel number and model, 
as well as the JTX file with the point addresses. 

ACTIONRES.DLL – DLL  (Dynamic-link Library) used to define the language. There are 
currently two languages available: Brazilian Portuguese (AVRESBRA.DLL) and 
International English (AVRESENG.DLL). 

COMMUNICATION MODULES - Each communication module (protocol) is implemented 
by creating a library which is accessed by the main application in real time, as 
required. The following are available in this version: 

�  AVDETECTOMGW.DLL - Communication protocol with Detectomat fire control panels. 
Client only. 

�  AVMODBUSG.DLL - MODBUS (RTU, ASCII, and TCP/IP) server and client protocol. 
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�  AVBACNETG.DLL - BACnet MS/TP client and server protocol. 

�  AVOPCSVGW.DLL - OPC Data Access server protocol compatible with versions 1.0 
and 2.0. Server only. 

22..22  DDii rreeccttoorryy  SSttrruuccttuurree  

2.2.1 Gateway Server Module 

During the installation of the CM&I Gateway a directory called Gateway  is created on the 
standard system disk or on another disk selected during installation. Seven subdirectories are 
then created: 

�  Prg: Where the CM&I Gateway system applications and libraries are copied to.  

�  Dbase: Where the basegtw.mdb system database and the Action.udl (Universal Data 
Link) file are copied to and reside. The Action.udl file points to the project database. To 
modify this file right-click on it and select properties .  

�  Logs: Directory used to generate the application log files, used in protocol checking 
processes. The list of points (in Excel format) is also stored in this directory, with the 
project point addresses.  

�  Help: Directory where the online help system is available.  

�  Backups: Directory where the files generated from a restore Gateway-PC process are 
stored.  

�  Installers: Directory where the files needed for the Gateway Client installation are 
available.  

�  JTX Files: Directory where the JTX files with the point addresses of a Detectomat 
project are stored. 

2.2.2 Gateway Client Module 

During the installation of the CM&I Gateway, a directory called GatewayClient  is created on the 
standard system disk or on another disk selected during installation. Two subdirectories are then 
created: 

�  Prg: Where the CM&I Gateway system applications and libraries are copied to.  

�  Sounds: Where the application audio files are stored. 

22..33  AA  CCMM&&II  GGaatteewwaayy  PPrroojjeecctt   

2.3.1 Parameters and Options 

A project is basically a set of parameter definitions regarding the communication channels and 
protocols used, as well as the directories where the program and the system database are.  

These parameters are stored in a text file with the name of the project and the .INI extension, in 
the system directory (WINDOWS or WINNT). Almost every parameter can be altered from the 
CM&I Gateway Interface. For users familiar with the product, modification made directly in the .INI 
file may be faster. 

2.3.2 Project Objects 

Channels 
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Channels are the logical communication paths which can be opened between the CM&I Gateway 
and other equipment or applications. In a communication channel, the user defines the protocol 
and its parameters. A communication channel can be of the Network (TCP-IP) or Serial type. 

Devices 

Devices (or IEDs) are the equipment with which the CM&I Gateway communicates through a 
channel. The devices always have two addresses: one which identifies the device uniquely, and 
another which identifies the input and output points within the device.  

Points 

Points are read and write data items, such as a loop condition, fire detectors status and analog 
and digital output values. Each point of a device must have at least one record in the addresses 
database table. This record describes the point attributes such as type (function of the protocol 
used), identification, address etc. 

On the CM&I Gateway, point identification is done uniquely by a pair of codes, defining a 
hierarchy: Group and Variable codes: 

Groups - A set of points which belong to the same piece of equipment, place or any 
logical group. For instance, a fire control panel could be considered as a Group. 

Variables  - Identify the inputs and outputs, such as loop condition and fire detectors 
status.  

The Group Variable  pair, in many supervisory programs, is named as the tag of the point. 
Examples of tag identification: 

 FCP_001.LOP001; 

PANEL_002.ZON005; 

 PANEL_001.Z005D002. 

22..44  DDaattaabbaassee  
The CM&I Gateway has a parameters database (BASEGTW.MDB), storing the definition tables of 
protocols available, the type of points for each of these protocols, and the telecommunications 
command and acquisition points description. The following items describe each table. 

2.4.1 “CanaisPEC”  Table 

This is the table which contains the project point addresses. Each tag identifies a specific 
input/output within a group, i.e. a loop condition or a fire detector status. The tag physical address 
has two fields: the device address and point address within the device. The format and 
interpretation of these addresses depend on the protocol used. See the section "Communication 
Protocols" for more details.  

2.4.2 “ ModulosComm ” Table 

This table contains the communication modules (protocol) record supported by the CM&I 
Gateway. 

Observation: This table should not be modified by t he user.  
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2.4.3 “ TipoPontos ” Table 

This table contains the codes, indexes and descriptions for the input and output point’s type 
associated to a communication module, in accordance with what is supported by the module. In 
the definition of each tag to be read or commanded, a code is selected to define the point type. 
Examples of point types: 

·  OSD – Optical Smoke Detector; 

·  HD - Heat Detector; 

·  LOP - Loop; 

·  ZON - Zone, Detector Zone; 

·  AI - Analog Input. 

Observation: This table should not be modified by t he user.  

2.4.4 UDL File 

The UDL (Universal Data Link) extension file used in MS-Windows describes a data source which 
may be accessed by applications through the OleDB or ADO – Activex Data Object access 
mechanism used by the CM&I Gateway applications.  

"In order to create a UDL type file, simply open the Notepad application (notepad.exe) and save a 
file, even an empty one, and save it with the ".UDL" extension". After that, just right click on the 
file, selecting Properties: 



CM&I Gateway Components 

 

 00015-02           7 

 
Figure 2 - UDL File - General. 

 

In the Provider tab, select “Microsoft Jet 4.0 OLE DB Provider”, which is the data provider for 
Access type files with .MDB extension, as used by CM&I Gateway. In the connection tab, the 
BASEGTW.MDB file has to be specified, in this case, pressing the three-point button and 
selecting the appropriate file in the directory. Then, press the Test Connection button, making 
sure the data source specification is correct. 
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Figure 3 - UDL File - Provider and Connection. 
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33..  SSttaarr tt iinngg  CCMM&&II  GGaatteewwaayy  

33..11  GGaatteewwaayy  SSeerrvveerr   MMoodduullee  

After installing CM&I Gateway, the group CM&I Gateway Server will be available in the 
Gateway-PC program menu (Start -> All Programs ), where the Gateway Server 
application can be started. This application will open a window with a set of menus, 
allowing navigation through the application configuration and project maintenance – see 
figure below. 

 
Figure 4 - CM&I Gateway Server Interface. 

3.1.1 CM&I Gateway Interface 

To open the CM&I Gateway Interface application which allows the setting of the project 
parameters, with the definitions of the communication channels characteristics, the 
protocols and the tags, select: Utilities -> Gateway Viewer.  The CM&I Gateway Interface 
application shown in the figure below has two distinct functions: 

�  In project time, when the application Gateway Runtime (SPPCOMGTW) is not running, it 
allows the user to create and modify projects, defining its channels, devices and tag 
addressing; 
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�  In real time, when the Gateway Runtime application (SPPCOMGTW) is running, it allows the 
user to view the data received and sent to devices and applications, to monitor the tag status, 
and to send commands to the output points. 

 
Figure 5 - CM&I Gateway Interface. 

3.1.2 Gateway Runtime 

The Gateway Runtime (SPPCOMGTW.EXE) application is responsible for reading the 
points table, for the database creation in real time and for the communication channels 
administration. Its start and stop are accessible by the Real Time menu in the CM&I 
Gateway Interface. 

 
Figure 6 - Starting the Gateway Runtime. 

Gateway Runtime does not have its own visual interface. Its functions are accessible 
through the Status, Events, Settings, Message List and Monitor Channel tabs in the 
CM&I Gateway Interface. The figure below shows the Message List tab, containing the 
data sent and received by two communication channels. This tab, as well as the ones 
mentioned above, are only available when the real time program is run. 
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Figure 7 - Messages List Tab in the CM&I Gateway Interface. 

3.1.3 DBCreator 

To start DBCreator - the database generation application for Detectomat fire control panels 
projects, select: Utilities -> Database Creator.  The following figure shows the DBCreator 
interface. 
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Figure 8 - DBCreator Interface. 

33..22  GGaatteewwaayy  CCll iieenntt   MMoodduullee  

After installing CM&I Gateway, the CM&I Gateway Server group will be available in the 
Gateway-PC program menu ( Start -> All Programs), where the Gateway Server application 
can be run. This application activates an icon in the Windows Notification Area - see figure 
below, which indicates the Gateway-PC status. 

 

Figure 9 - Gateway Client Icon in the Notification Area. 

In order to establish connection with the Gateway PC and to have access to the Gateway 
Server Interface, right click on the Gateway Client icon, and select Show gateway, as 
shown in the figure below. 
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Figure 10 - Connecting to the Gateway Server. 

33..33  SSooff ttwwaarree  PPrrootteecctt iioonn  

3.3.1 Forms of Protection 

The protection system allows each copy to be used on only one computer. This type of protection 
requires an authorization code to be provided to the program, which can be obtained by e-mail or 
by phone from Ruhcon Inc. Another alternative is to use a dongle connected to the computer on 
which the CM&I Gateway is installed. 

3.3.2 Running in the Demonstration Mode 

When the CM&I Gateway is started without a dongle installed and no software activation code 
entered, a pop-up window will indicate that the application requires authorization. 

 
Figure 11 - Software Protection Activation Window. 

Click the Exit button and a message will come up indicating that the application will run in the 
demo mode, as shown in the figure below. Press OK to continue. In demo mode all functions and 
program features work, but only for a limited time. After six hours the program ends automatically. 
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Figure 12 - Running in the Demonstration Mode. 

3.3.3 Running Authorization 

In order to fully run the system, the SERIALIZATION CODE appearing in the software protection 
window must be copied and then send to Ruhcon Inc. 

Licensed users will receive a code for their computer, compatible with the required licenses and 
protocols. This code must be inserted in the same alert window, in the ACTIVATION CODE field. 
After entering the code provided, press the Enter Activation button, and the authorization will be 
activated. 

3.3.4 License Transfer 

The software license may be transferred from one computer to another, by following the steps 
below: 

Install the CM&I Gateway in the computer to which the license is to be transferred. Run the 
application, and when the authorization request window appears, press the Prepare Transfer  
button. The program will request a USB memory device and prepare the transfer process on to it. 

Then return to the computer where the license was installed and run the authorized application. 
Press the Transfer License  button, which is shown in the CM&I Gateway Interface SUPPORT 
screen. It will then request the USB memory device prepared on the other computer. Insert the 
floppy disk and the license will be transferred to the new computer with the old computer will no 
longer being authorized. 

Run the application in the computer to which the license is to be transferred. When the request 
authorization window appears, press the Transfer button. The USB memory device with the 
license will be requested. Insert it and the license will be transferred with the authorization to run 
the application being activated. 
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44..  CCMM&&II  GGaatteewwaayy  SSeerrvveerr   

44..11  UUtt ii ll ii tt iieess  

4.1.1 Database Creator 

4.1.1.1 Description 

This option opens the DBCreator application used to generate a project database for the 
Detectomat fire control panels. This tool was developed to make the database creation process 
easier. The user only has to enter the project parameters, like the panel model and loop numbers, 
and the JTX file, which contains the hardware point addresses (fire detectors, manual call points, 
input modules, conventional zone modules, etc.). 

The DBCreator has a library which contains the Detectomat fire control panel monitoring 
variables. When a model is selected, the corresponding variables group is selected, and the 
points are created in the database. The point addressing follows the rules set in the project 
communication channel parameters. Therefore, make sure the communication channels are 
correctly configured before running DBCreator. 

The hardware points creation and addressing is done by reading the JTX file, which contains the 
logical address and the panel addressable devices description. 

4.1.1.2 The JTX File 

The JTX file – see figure below – is generated by a Detectomat proprietary program, and has 
information about the logical address, created by the Zone:Detector pair, about the description 
(Customer Text) and about the panel addressable devices type. 

 

 
Figure 13 – Example of a JTX File. 

 

In the JTX file, the information is separated by the colon and semi-colon characters. The first 
column contains a line order number inside the file; the second column shows the panel number, 
the zone (Gruppe) number, and the detector (Melder) number; the third column shows the 
detector description; and the forth column contains information on the device type (ORM, 
Optischer Rauchmelder). 

4.1.1.3 Starting DBCreator 
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To start the DBCreator, select it from the Gateway Server main menu: Utilities -> Database 
Creator.  

4.1.1.4 DBCreator Interface 

The DBCreator application interface is shown in the figure below: 

 
Figure 14 - DBCreator Interface. 

4.1.1.5 Using the DBCreator 

To generate a Detectomat fire panel database using the DBCreator, follow these steps: 

1. In the Panels  field, select an existing panel from the list, or type the desired name to 
create a new panel. This name will be used as the created points tag Group. 

2. In the Panel Model  field, select the Detectomat fire control panel model. The supported 
models are detect3004 and detect3016. 

3. In the Loops  field, select the number of addressable loops according to the number of 
loop boards connected to the panel. 

4. In the Import File  field enter the JTX file path corresponding to the selected panel in the 
Panels field. Click on the Search button to select the file. 

5. In the Zones  field, select the number of zone monitoring variables to be created. None = 
no variable will be created; All = one variable for each supported zone will be created, 
which means 128 variables for the detect3004 model and 192 for the detect3016; From 
Imported File = one zone monitoring variable will be created for each zone with detectors 
that is found in the JTX file indicated in the Import File field; Custom = N zone monitoring 
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variables will be created, from zone 1 to zone N, where N is the number inserted by the 
user in the Number of Zones field. 

6. Press the Create button to generate the database. 

7. When the generation is complete, press OK to end the operation. 

 

 
Figure 15 – DBCreator Generation Completed. 

4.1.2 Export Point List 

This option allows the export of the project point list to an .XLS file (MS Excel). This file contains 
the group name, the variable name, the description, and the data concerning each database point 
addressing. 

In order to generate the project point list, select Utilities -> Export Point List from the Gateway 
Server main menu. The generated files will be stored in the Gateway-PC Logs  subdirectory. For 
more details, see Section 2.2 - Directory Structure). The figure below shows an example of an 
exported point list. 

 

 
Figure 16 – Exported MODBUS point list. 

4.1.3 Gateway Viewer 

4.1.3.1 Description 

This option opens the CM&I Gateway Interface (SPINGATE.EXE) application, used in the 
parametrization of a project, and controls the Gateway Runtime (SPPCOMGTW.EXE) start 
and stop. The CM&I Gateway Interface allows the defintion of the communication channels 
characteristics, the protocols and the equipment input and output points. It also contains the 
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interfaces to monitor the data transmission with equipment and applications in real time in 
order to send write commands, and to view the events. 

The figure below shows the main screen of the CM&I Gateway Interface. In the upper part of the 
screen, there is a command menu. The desktop area has two panels, which are used to view the 
current project database objects. The left panel shows a tree list with the configuration of the 
database objects hierarchy. 

 

 
Figure 17 - CM&I Gateway Interface. 

 

The right panel is used to show the point status or a list of the last events generated. This part 
works only if the Gateway Runtime module is running. In the lower part of this interface, there is a 
status bar which shows messages referring to the last activities performed, as well as the current 
date and time. 

 

4.1.3.2 Command Menu 

The command menu is on the upper part of the CM&I Gateway Interface window, with the 
following options available: File, View, Real Time, Tools  and Help . To access them, click on the 
desired word or press the Alt key and the underlined command letter. When the menu opens, 
click on the selected option or key the underlined letter of the desired alternative. 

4.1.3.2.1 Command Menu - File 

This menu contains the subitems: New Project, Open Project, Edit Tags and Exit. 
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Figure 18 - Command Menu - File 

File - New Project 

When the item New Project is selected, a new window opens to select the new project 
parameters file name – see figure below. This file will be saved in the system default directory 
(WINDOWS or WINNT). 

 
Figure 19 – New project creation window. 

Click on Save to create the project file. A window will then open, as shown below, to define the 
new project database directory. 
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Figure 20 – Creating the new project database. 

Proceed as follows: Select BaseAction() from the drop-down menu and click on the  button to 
create the new database destination directory: 

 
Figure 21 – Creating a database directory. 
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Then, create a new directory and name it as required. It is recommended to create the new 
directory within the Gateway directory. Press OK to continue. This procedure copies two files to 
the selected folder: The first, named BASEGTW.MDB, is the empty database provided with the 
installer; the second is the ACTION.UDL file, which points to the newly created database. For 
more details, see section 2.4.4 The UDL File. A window will pop-up, showing the procedure was 
successful. 

 
Figure 22 – Copying the empty initialization file. 

Note that the ACTION.UDL file, created in the new directory, automatically points to the recently 
created database – figure below. 

 

 
Figure 23 – UDL File – Recently created database connection. 
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If the Gateway-PC is used for only one application, the SPING.INI project can be used, a 
standard (blank) project which monitors the Gateway-PC, and the blank 
\DBASE\BASEGTW.MDB database, provided with the installer. However, if the Gateway-PC is 
used for multiple applications, the standard files provided should be preserved, once they will be 
copied to each new project. 

File - Open Project 

This item is used to open an existing project. When selected, a dialog box opens to select the 
existing project file (.INI file) – see figure below. This file will be stored in the system standard 
directory (WINDOWS). 

 
Figure 24 – Opening a project. 

Select the project and click OPEN. The software will assume the recently opened project 
characteristics. This same environment might also be selected, activating the application with the 
project name as the argument in the command line. See the example below: 

C:\Gateway\Prg\spingate.exe NewProject 

File – Edit Tags 

This form shows a table with the tags records defined in the Gateway Server, including the 
physical address and other attributes used in the point definition – see the next figure. 
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In a Gateway-PC, each tag will have a record for each communication module by which the 
point will be treated. Usually, two records are created: One for the communication module of 
origin and one for the destination communication module. The addresses format varies 
according to the communication module, and is related to the way with which the protocol 
exchanges information with the corresponding IED. 

General tag attributes, such as type (input or output, analog or digital), dead band, scale, etc., 
should be compatible between records, as in the real time database generation, only the first 
record corresponding to the same tag identification – Variable Group – will the attributes be 
stored. 

In regard to the attributes of each communication module, such as point type and address, each 
record will have attributes compatible with the protocol in use. For details, see Chapter 6 - 
Communication Protocols. 

 
Figure 25 - Tag editing table. 

File – Edit Tags: Table Fields 

This form has the following fields: 

Protocol  – Defines the protocol associated to this record. Click on the field to see the 
communication protocols defined in the channels specified for this project. The registration of 
these channels must be done in the objects tree; 

Group/Variable  – Identifies a point tag, according to the objects hierarchy used in the CM&I 
Gateway database; 

Type – Shows a list of the point types supported by this record protocol; 
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Address1  – First point level physical address. It is always the equipment (IED) address, which 
contains the information on the monitored point. Some protocols require a complementary 
attribute specification, such as a scan group, block, etc.; 

Address2  – Second level tag physical address. It is the point address of the equipment.  
Depending on the protocol, it may be in decimal or hexadecimal format, indicating bit fields or 
otherwise, etc.; 

Dead Band  – It creates a dead band for an analog measurement, which means a value interval 
within which a measured value variation does not generate events. This value is entered as a 
percentage, which may be applied to the last value sent spontaneously or by the time elapsed;  

Thus, events will be generated only when the difference between the two continuous readings – 
or between two readings performed within a specified period – exceeds the upper or lower 
calculated dead band limit. A zero value deactivates this mechanism; 

Sampling  – Maximum time, in seconds, within which the value of an analog measurement since 
last send has to exceed the dead band so that a spontaneous event is generated. A zero value 
deactivates this timer. 

Scale – Decimal scale modifier. The value shown by the Gateway-PC will be the product of the 
read value by 10^N, where N is the multiplier. This value may be positive or negative. A zero 
value implies that the decimal scale will not be modified, which means the presented value will be 
exactly the read value; 

Span – Beginning and end scale values, in engineering units, to allow the generation of 
normalized measurements (integers between -32768 and +32767, for 16bits normalized); 

Parameter  – This is a whole number used by certain protocols to specify a telecommunication 
command attribute. It may indicate, for example, a selection between continuous or intermittent 
output. 

Events  – This Boolean variable (0 or 1) defines if an event should be generated when a point 
status is modified (digital points), or when a dead band is exceeded (analog measurements). The 
generated events are labeled with a timestamp, and then inserted in a line, becoming available to 
the protocols which use spontaneous events. 

Description  – This field is filled in with a point description for better identification.  

File – Edit Tags: Buttons 

The following buttons are on the bottom of the form. 

New – Opens a new empty line, immediately below the line where the cursor is, allowing the 
addition of one more record; 

Save – Saves the table after the changes are made. The changes made to the table are only valid 
if they are saved; 

Delete – Deletes the selected records; 

Print – Allows printing of the table; 

Exit  – Closes the form without saving the changes; 

Help  – Activates the help associated to this form; 

 Button to cut a set of records; 

 Button to copy a set of records; 
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 Button to paste a set of records; CAUTION: Before pasting a set of records, make sure the 
cursor is on the last line of the table. If it is not, the pasted records will overwrite the existing 
records. 

 and  - Used to classify the database records in alphabetical order, ascending or 
descending. These buttons are only available when the columns are selected – see figure below. 

 
Figure 26 - Tag table classification 

File - Exit 

This item is used to close and exit from the CM&I Gateway Interface. The same happens if the 
exit button on the upper left corner of the window is clicked. These two ways of closing the 
interface do not interrupt the Gateway Runtime (SPPCOMGTW.EXE), if it is running. 

4.1.3.2.2 Command Menu - View 

This menu contains the CM&I Gateway Interface view configuration options – see figure below. 
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Figure 27 - Command Menu – View. 

View – Status bar 

This item is used to enable or disable the application Status Bar viewing, shown at the bottom of 
the window – see figure below. 

 
Figure 28 - CM&I Gateway Interface Status Bar. 

View – Refresh Tree 

Clicking on this item updates the CM&I Gateway Interface tree objects data – see figure below. It 
must be used when points are included or excluded by the Edit Tags item in the File command 
menu. 
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Figure 29 - CM&I Gateway Interface Project Tree. 

View - Save Events 

This item is used to enable or disable the events storage option, which are generated by the 
Gateway Runtime for viewing. CAUTION: Only the points with the enabled Generate Event 
attribute will have their events stored when the Save Events option is enabled. The Generate 
Event attribute can be modified with the Edit Tags item in the File command menu. 

4.1.3.2.3 Command Menu – Real Time 

The Command Menu contains the items to control the Gateway Runtime module and to send 
commands to the output points - see figure below. 

 
Figure 30 - Command Menu – Real Time. 

Real Time - Start 

This item starts the Gateway Runtime (SPPCOMGTW.EXE) with the current open project 
characteristics. After starting the real time module, the right panel becomes available, showing 
the tabs: Status, Events, Simulator, Message List, and Monito r Channel. This item is not 
available when there is not enough information to start the real time module. 



CM&I Gateway Server 

 

28           00015-02  

Real Time - Stop 

This item is used to halt the Gateway Runtime application. The CM&I Gateway Interface also 
stops when the Gateway Runtime is halted. This is why a confirmation is required when the 
Gateway Runtime application is stopped - see figure below. This item is enabled only when the 
real time module is running. 

 
Figure 31 – Gateway Runtime closing confirmation 

Real Time – Data base reload 

This item is used when new points are added to the project database. When activated, this item 
closes the existing communication channels and restarts them, including the added points in the 
real time database assembly process. 

Real Time - Command 

This item allows (written) commands to be sent to the output points. It is enabled only when the 
real time module is running. The selected point must also be an output point. To send a 
command, select a point from the project tree, and on the Real Time menu, click Command. A 
dialog box will open to set up the command parameters – see figure below. 

 
Figure 32 – Send command window. 

This dialog box contains the following fields: 

Output Tag  – Shows the selected point identification. 
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Answer Tag  – Optional field. In order to verify if the sent command was correctly processed, 
specify the input tag to indicate the output status commanded.  

Parameter  – In some communication modules, as well as the point tag to be specified,  an output 
parameter has to be informed, specifying the form of the command. The value entered is sent to 
the communication module. If there is an output parameter defined in the database, it will be 
shown on this field. 

Value – In case a communication module command requires the sending of a value – a setpoint, 
for example – the desired value must be entered in this field. If there is a value specified in the 
database, it will be shown on this field. 

Log type  – This value is used by some communication modules to identify events. When a 
command is sent, its code is included in the generated log, making its interpretation easy. 

For more details on how to set up the Parameter, Value and Log Type fields for each 
communication module, see Chapter 6 – Communication Protocols on this manual. 

Command Menu - Tools 

This contains the items to configure the CM&I Gateway Interface and to register the application – 
see the figure below. 

 
Figure 33 - Command Menu – Tools. 

Tools - Options 

This sub-item allows the general options for running the current project to be viewed and 
changed. When selected, it opens a three tab window: Directories , Languages, and  General . 

Tools – Options - Directories 

This tab allows the definition of the directories where the project files and applications are stored. 
For a database, set this to the directory where the BASEGTW.MDB file and the .UDL file, which 
points to this data source, will be created. 

To change a directory path, press the  button and select the desired folder – see the figure 
below. 
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Figure 34 – Window to select and/or create directories. 

 

After selecting, press OK. CAUTION: When changing or creating a directory, the files, 
applications, and libraries must be moved to the appropriate folders. After moving the files, the 
CM&I Gateway Interface must be registered again. 

Tools – Options - Languages 

This tab allows the selection of the CM&I Gateway Interface language. The current version 
supports English and Portuguese – see the figure below. If the CM&I Gateway Interface language 
is changed, it must be restarted for the changes to take effect. 
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Figure 35 – Language selection tab. 

Tools – Options – General 

This tab is used to specify the general options of the project, such as the owner’s name, 
maximum events number and status window update period – see the figure below. 

Owner  – Allows the definition of the name or acronym of the Gateway-PC owner. This name will 
be used on the Licensing and Product information windows. 

 
Figure 36 – Defining the project owner. 
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Maximum Events  – maximum number of events shown on the Events Window. The events are 
exhibited from the most recent to the oldest. The top limit for the number of events in real time 
queue waiting to be shown is 3000, which means that only the last 3000 events may be exhibited. 

Status Window Update Period  – Time, in milliseconds, between two successive information 
updates shown in the Status Window. 

Tools - Register Application 

This sub-item may be used to trigger the OCX record processes and the OPC server, used by the 
Gateway Server. In the normal Gateway Server installation, these processes are executed 
considering the current open project name and the applications directory specified within it. 

Tools - Edit project 

The parameters that define a Gateway Server project are stored in the .INI file, with the name of 
the project. The majority, if not all these parameters, may be modified by the options available in 
the command menu and the project tree. Nevertheless, if the user so wishes, it is possible to edit 
these parameters directly from the project file, using the MS WINDOWS NOTEPAD.EXE 
application. 

4.1.3.2.4 Command Menu - Help 

This item is used to obtain the help topics. content, and information on the application. 

 
Figure 37 - Command Menu – Help. 

Help - Content 

This allows access to the online help file contents. 

Help - About 

This shows the window identifying the program, licensing, copyright, etc. 

 

4.1.3.3 Objects Tree 

4.1.3.3.1 Tree Content 

On the left panel of the CM&I Gateway Interface main screen there is a list of the project objects 
and database, organized in a tree format. This list, called the objects tree, shows the current 
project entities organized hierarchically. 

When the application is started, the objects tree is closed and it shows only the project acronym. 
The objects tree may contain the following folders: Channels, devices (IEDs), point groups, and 
points (sorted according to their type: digital or analog) – see figure below. Because they are 
defined in the project file (INI), Channels and Devices are shown all the time. However, the part 
referring to Groups and Points is only shown when the Gateway Runtime is activated. 
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Figure 38 – Objects Tree. 

4.1.3.3.2 Moving through the tree 

In order to expand the tree to show the lower level objects on the left panel, double click on the 
object or click on the + symbol, in front of the object description. 

When the tree is expanded, one of its lines will be highlighted. The selection may be changed by 
the arrow keys (up and down), or by using the mouse. 

Clicking on the lines which contain the object name, the tree is expanded and the table records 
list can be viewed.  Clicking again, the tree will be shrunk. 

To view the Channels and Devices properties, right click on the desired Channel or Device. 

 

4.1.3.4 Communication Channels Editing 

4.1.3.4.1 Add Channel 

To include a new communication channel, right click Channels on the objects tree and left click 
the Add Channel option – see figure below. 
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Figure 39 – Adding a new channel. 

The new channel will be named with the first available channel number, starting from 0. In the 
example, the project already has two channels, which means the next will be named Channel2. 

 

CAUTION: While the Gateway Runtime is running, channels can be added or removed. However, 
these changes will only be made after the Gateway Runtime is closed. When changing only the 
properties of a channel, only the modified channel has to be restarted, without having to close the 
Gateway Runtime. 

 

When a channel is created, a window is opened containing the tabs to enter communication 
parameters. When opened for the first time, the window shows two tabs: General and Advanced 
– see figure below.  As the channel type and the communication protocol are defined, new tabs 
will appear to define specific properties. When a new channel window is opened, the selected tab 
is the General tab, and the channel number is already shown. The other fields are empty. 

4.1.3.4.2 Channel - General 
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Figure 40 – Adding a new channel. 

 

The fields on this tab then have to be completed: 

Description  – Optional text describing the channel function and use; 

Type – The channel type will be selected from the list: SERIAL, NETWORK or DUMMY. 

1. SERIAL: Specifies that the physical means of communication uses serial communication 
ports, such as COM ports; 

2. NETWORK: It must be selected for the communication using LAN networks over TCP-IP 
protocol. Used by the TCP-IP encapsulated application protocols and by the 
communication through TCP-IP sockets on the same computer. 

3. DUMMY: Used for communication modules that do not use physical communication 
channels, such as the OPC Client, or their own protocols, which already have their own 
communication system. 

Protocol  – Select the communication protocol to be used by this channel from this list. For more 
details about the protocols available, see Chapter 6 – Communication Protocols. 

After completing the General tab, a third tab will open with the type name selected. 
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4.1.3.4.3 Channel - SERIAL 

When the SERIAL type is selected, a tab is shown to specify the parameters of each SERIAL 
communication channel – see figure below. 

 
Figure 41 – Serial type channel. 

 

Settings – Speed definition (in bps), parity, data bits number, and serial port stop bit. 

Port  – Serial communication port number. E.g. 1 = COM1 port; 2 = COM2 port; etc. 

Slave Port – Insert the slave port number on the same serial communication channel. The slave 
port is used when there is a duplicated means of communication  and either one can be used. 
The default value is 0, showing that there is no slave port. 

Without any timeout occurring, the activity in the main port will be maintained for as long as the 
communication in the main channel is normal. When there are consecutive timeouts, the Gateway 
Runtime (SPPCOMGTW.EXE) module will transfer the communication channel to the alternative 
port. 
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Controls Flow –  Defines the communication flow control: None (0) = no flow control; XON/XOFF 
(1) = software flow control ; RTS/CTS (2) = hardware flow control. 

RTS OnDelay –  Valid for SERIAL channel with RTS/CTS (2) flow control. Defines the time, in 
milliseconds, while the RTS signal is kept high, before the data transmission. This is a useful 
resource when using radio communication with a half-duplex channel. 

RTS OffDelay –  Valid for SERIAL channel with RTS/CTS (2) flow control. Defines the time, in 
milliseconds, while the RTS signal is kept high, after the data transmission is complete. This is a 
useful resource when using radio communication with a half-duplex channel. 
 

4.1.3.4.4 Channel - NETWORK 

When a NETWORK channel is selected, a tab is shown for the definition of the network 
communication channels parameters with TCP-IP protocol – see the figure below. 

Client x Server 
The NETWORK channel has to be specified as a client or server. As a client, the connection 
attempt is made from the CM&I Gateway by sending read requests. This configuration is typically 
used by the Gateway-PC in IED data acquisition. As the server, the communication channel waits 
for an external connection to send data, and sends it according to the read request received. This 
configuration is used to provide data to other devices or applications, such as SCADA software, 
for example. 

 
Figure 42 – NETWORK channel. 
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Client channels require the server computer IP and the TCP port configuration. Server channels, 
however, require only the port definition – the IP address linked to the server ports is the 
Gateway-PC IP. 
 

Master Remote IP  – This field must be filled in. It has to contain the IP address or the server 
computer name. 

Slave Remote IP  – It has to contain the IP address or the slave server computer name when the 
system is configured as Hot-Standby. 

Port  –The input socket port number in the server channel must be filled in, or, alternatively, with 
the output socket in a client channel. 

4.1.3.4.5 Channel - Advanced 

This tab – see figure below – is shown to both NETWORK and SERIAL channels, and already 
comes with the appropriate values for most of the objects. 

 
Figure 43 – Channel advanced parameters. 

 

TimeSleepActivate  – Suspension time in the protocols activation control thread between two 
consecutive executions of the main loop. 

TimeSleepReceive  – Suspension time in the protocols data reception control thread between two 
consecutive executions of the main loop. 
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LogReport  – If different from zero, it specifies the information which must be included in the log 
file of each channel . The button on the right of the attribute opens a dialog box with all the 
selected information – see figure below. 

 
Figure 44 – Configuring the Log Report. 

 

LogReport – General - Output Modes  – Controls the messages destination. One or more 
options can be selected: 

·  None = it does not generate reports; 

·  On Disk = it generates the log on a disk; 

·  Show Message Box = it shows an inbox, in case of error detection. 

 

LogReport - General - Log Status  –Specifies the error presentation level: 

·  No message is shown; 

·  Only Critical Errors; 

·  Only Database Errors; 

·  Only Debug Information. 

 

LogReport - General - Log Size  – Specifies the log file size (in Kbytes). This log works as a 
queue: After reaching the storage limit, the oldest messages are replaced by the new ones. 

LogReport - By Channel  – Allows the selection of the options which will be shown in the channel 
log file. The values for each option are: 

0 = No log generated; 

1 = Stores the sent frame; 

2 = Stores the received frame; 

4 = Communication status (0 = failure, 1 = OK); 
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8 = Communication Status Window; 

16 = Data Sending Status Window; 

32 = Data Receiving Status Window; 

64 = Data Statistics Window; 

128 = Thread update information; 

CAUTION: The values above are cumulative, which means that in the parametrization (.INI) file, 
the LogReport field is shown as the total of the selected options. 

Show Status  – When selected, the communication status window shown on the CM&I Gateway 
Interface is active; 

Show Statistics  – When selected, the statistics window shown on the CM&I Gateway Interface is 
active; 

Statistics Interval  – Time interval, in milliseconds, between two consecutive communication 
channel status information collections; 

Wait Timeout  – Applicable to the NETWORK channels. It defines the maximum wait time during 
connection acceptance of blocked operations by the server channels. After this period, the accept 
operation is repeated. 

Read Timeout  – Applicable to the NETWORK channels. It specifies the maximum wait time, in 
milliseconds, in the blocked reading of messages operations. After that, there is a new read 
attempt. 

Number of Attempts – Number of transmission/reception attempts performed before reporting a 
connection error. 

 

4.1.3.4.6 Channel – Protocol 

The last channel properties tab refers to the selected communication protocol parameters 
configuration – see figure below. The protocol configuration tabs are detailed in Chapter 6 – 
Communication Protocols. 
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Figure 45 – MODBUS protocol configuration tab. 

 

4.1.3.4.7 Channel Removal and Modification 

Right click on a channel to show the menu with the following options: (see figure below) Add 
Channel , Remove  Channel, and  Properties : 

 
Figure 46 – Removing and modifying channels. 
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Add IED  – Used to add an IED to this channel. For more details, see item 4.1.3.5 – Devices 
Editing. 

Remove Channel  – Removes the selected channel and all its devices (IEDs). If there are 
channels whose number is greater than the removed one, the last existing number will take  up 
the removed number. 

The tags associated with the removed channel IEDs will not be automatically removed from the 
points table. If necessary, this removal must be done manually. 

Properties  – Opens the channel properties window, showing the current configuration channel 
tabs. To modify the channel parameters, see the description of each tab in the beginning of this 
section. 
 

4.1.3.5 Devices Editing (IEDs) 

4.1.3.5.1 Adding Devices 

To add a new IED to a channel, select the desired channel in the objects tree, right click on the 
options menu, and then select Add IED. The IED properties window will then open. Each 
communication protocol has its own IED window. 

In any protocol, this window will be used to insert a Device Address, an optional text to describe 
the device, and Device x Protocol attributes. The figure below shows a MODBUS protocol IED 
window. Besides the IED address, it is also possible to specify in which order the variables will be 
treated, according to the type. For more details on the IEDs attributes of each protocol, see 
Chapter 6 – Communication Protocols. 
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. 

Figure 47 – Adding devices. 

 

4.1.3.5.2 Devices Removal and Modification 

Right click on an IED to show the menu with two options: (see figure below) Remove  IED and 
Properties:  

 
Figure 48 – Removing and modifying devices. 
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Remove IED  – This removes the selected device (IED). If there are IEDs whose number is 
greater than the removed one, the last existing number will take the removed number. 

The tags associated to the removed IEDs will not be automatically removed from the point 
schedule. If necessary, this removal must be done manually. 

Properties  – This shows the IED properties window with the current parameters. If desired, the 
user may change any parameters on this tab. For more details on the IEDs attributes of each 
protocol, see Chapter 6 – Communication Protocols. 

 

4.1.4 Gateway Runtime (SPPCOMGTW.EXE) 

4.1.4.1 Description 

The Gateway Runtime (SPPCOMGTW.EXE) application is responsible for reading the point 
schedule, for the database creation in real time and for the communication channels 
management. 

The Gateway Runtime does not have its own visual interface. Its functions are accessible through 
the Status, Events, Settings, Message List and Monitor Channel tabs in the CM&I Gateway 
Interface. These tabs allow viewing of the configuration parameters, message flow and channel 
status - see figure below. 

 
Figure 49 - Gateway Runtime Tabs. 

 

The content of these tabs is described in detail below: 

·  Status – Window showing the point data in real time; 

·  Events – Window showing the systems last events; 

·  Simulator – Window to configure the point data simulation; 

·  Settings – Window with the communication channels settings; 

·  Message List – Window to monitor the exchanged message frames. It allows 
viewing of messages simultaneously from several different channels; 

·  Monitor Channel – Window to show channel messages and status. 
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4.1.4.2 Gateway Runtime Windows 

4.1.4.2.1 Status 

The STATUS window is shown when the STATUS tab is selected. Each line on the list represents 
the current status of a point configured on the Gateway-PC database. This list shows only the 
selection position in the objects tree. In the upper part of the window, above the tabs, the name of 
the current point selection can be seen – see figure below. 

 
Figure 50 - Gateway Runtime – Status. 

 

The statuses shown are constantly updated in real time. The points update speed can be 
changed on the menu: Tools –> Options –> General.  

See the STATUS window columns description below: 

·  Number  – Internal number by which the point is known in the database in real time; 

·  Tags – Point identification on an IED. Concatenation of the Group name and of the 
Variable of the point; 

·  Value – Current point value. Represents the current status of digital variables and 
the current measurement of the analog variables; 

·  Date – Date and time of the last update of the point in the database. According to 
the protocol, it may be configured to get the time and date from the field or to use 
the date and time from the Gateway-PC; 

·  Activated  – Activation status of the point (0 = disabled  and 1 = activated); 
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·  Simulated  – Specifies if the point is being read from the IED or manually simulated; 

·  Status  – Point status regarding errors. This definition follows the ICB byte quality 
standard of the IEC protocols.  If no failure is identified, the point Status will receive 
a zero value, showing it is OK. 

 

POINT STATUS 

Bit  Value Description  Error 
Code 

7 
1 

Invalid value due to communication failure or 
other error. 128 

0 Valid normal. - 

6 
1 

This value has not been updated by the data 
acquisition at the normal frequency: the value for 
real time is old. 

64 

0 Normally updated value. - 

5 
1 This value was replaced by the operator 

(simulation) or other automatic means. 
32 

0  Normal value of the field. - 

4 
1 

Inactive or blocked for transmission. Value is not 
being monitored. 16 

0 Value normally monitored. - 

0-3 - Not used. - 

 

4.1.4.2.2 Events 

The EVENTS window is shown when the EVENTS tab is selected. An event is a message 
generated by the real time monitoring of the points in the database, when a variable value 
changes. Each line of the table represents an event inserted in the events queue – see figure 
below. 
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Figure 51 - Gateway Runtime – Events. 

 

In the tags parameterization table, there is an Events attribute, which specifies if a record must or 
must not generate events. The events are generated and inserted in the events queue, in 
accordance with the alarm attributes and the events defined in the database. 

To store the events for later review, the Save Events option from the View menu has to be 
enabled. The last 3000 events are stored in a real time database. This database creates an 
events queue: After reaching the storage limit, the oldest events are replaced by the new ones. 
The number of events shown may be configured in: Tools > Options > General > Maximum of 
Events.  

The objects tree operates as a filter to define from which group of points the events will be shown. 
It is possible to select from among different variable groups and, within the same group, from the 
digital or analog variables. The events window is static, unlike the status window. In order to 
update it, another tab has to be selected and then return, or change the group selected. 

The Events window has the following data columns: 

·  Event Number  – Internal sequential number given to the event in real time; 

·  Tags – Point identification by the Group and Variable name; 

·  Date – Date and time of the occurrence of the event. The date may be obtained from 
the field or generated by the communication module when including the new status in 
the real time database; 

·  Value – Current variable value; 

·  Event Type  – Numerical code to define the different types of events. 

4.1.4.2.3 Simulator 
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The SIMULATOR window is shown when the SIMULATOR tab is selected. In the SIMULATOR 
window, it is possible to set up the points in the database so that their values are internally 
simulated in the real time module, making demonstrations, tests and failure diagnosis easier. This 
window also allows control of the status of the simulation process, as well as showing all the 
points currently set up for simulation and their parameters - see figure below. 

 
Figure 52 - Gateway Runtime – Simulator. 

 

This window is divided in two record groups. The list on the left gathers all the points of the 
selected group in the project tree. The list on the right includes only the variables that are to be 
simulated. The points on the simulation list are not updated with the values received from the field 
by the communication modules, even when the simulation is not running. 

A set of parameters is linked to the points group: initial value, minimum value, maximum value, 
increment and periodicity. When the simulator is running, the Gateway Runtime reads the 
simulated points current value every 200ms and, based on the simulation parameters, increments 
the value of the points. 

With analog points, each time the point value reaches the maximum or minimum, the increment 
signal is reversed, and the countdown restarts from the lower limit. 

At the bottom of the SIMULATOR window, there is a panel with fields where the simulation 
parameters are specified, as described below: 

·  Initial Value  – Value attributed to the point at the beginning of simulation; 

·  Minimum Value  – Lower limit for the set of values the point may take;  

·  Maximum Value  – Upper limit for the set of values the point may take; 

·  Increment – Value added/removed to/from the current value at each update; 

·  Update Time – Period, in milliseconds, between the two consecutive point value 
updates;  

·  Simulator Button Running/Static –  Button which shows the simulator current status. 
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To begin the simulation of a set of points, follow these steps: 

·  Select the SIMULATOR tab; 

·  Select the points group which contains the tags to be simulated from the objects tree; 

·  In the SIMULATOR window, select tags from the selected group to be added to the 

simulation. Use the Shift and Ctrl keys to select. Then, click on the  button to 
continue; 

·  In the parameters configuration panel, change the value in the fields; 

·  Start simulation by clicking on the  button. 
 

 
Figure 53 – Adding points for simulation. 

 

To remove points from the simulation list, just select the desired records and press the removal 

button . 

 

4.1.4.2.4 Settings 

The SETTINGS window is shown when the SETTINGS tab is selected. This window describes 
the setting of each communication channel set up in the Gateway-PC – see figure below. 
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Figure 54 - Gateway Runtime – Settings. 

 

The SETTINGS window fields are: 

Station – Shows the computer name; 

Settings – Describes the project parameterization file name (.INI file); 

CANAL0 AND CANAL1 – Store the channel parameters current settings. These parameters are 
the same as in the Properties window, accessible by right clicking on the objects tree channel. 

CAUTION: If there is a high number of channels, the channels settings information will be paged 
with up to 25 channels on each page. In this situation, a page number and a control to navigate 
through the pages will appear in the upper right corner of the SETTINGS window. 

4.1.4.2.5 Message List 

This window is shown when the MESSAGE LIST tab is selected. It is possible to view the sent 
and received messages on a certain channel or on a group of communication channels of the 
Gateway-PC. The messages are shown as bytes in hexadecimal representation – see figure 
below. 
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Figure 55 - Gateway Runtime – Message List. 

All the messages processed by the Gateway-PC are identified with a timestamp. Messages sent 
by the Gateway-PC are also identified with the SND label, whereas the received messages have 
the REC label. 

At the bottom of the screen, the numbered squares represent the communication channel status. 
The table below summarizes what each color indicates. 

 

Channel Type  
Chann
el OK 

Channel 
Failure  

Client – Requesting data to the IEDs Green  Red 

Client – Requesting data to the IEDs. Slave in 
Hot Standby settings. 

Blue  Blue  

Server – Providing information to the 
applications (SCADA software) or IEDs. 

Green  Red 

Server – Providing information to the 
applications (SCADA software) or IEDs. 
Master in Hot Standby settings. 

Blue  Pink  
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CAUTION: If there are a high number of channels, the communication channel status information, 
as well as the buttons to select it will be shown with up to 25 channels on each page. In this 
situation, a page number and a control to navigate through the pages will appear in the upper 
right corner of the MESSAGE LIST window. 

4.1.4.2.6 Monitor Channel 

This window is shown when the MONITOR CHANNEL tab is selected. A communication channel 
can be monitored more precisely in this manner. This window, unlike the MESSAGE LIST, allows 
monitoring of only one communication channel at a time – see figure below. 

 
Figure 56 - Gateway Runtime – Monitor Channel. 

 

The RESET button allows the communication channel to be restarted. When it is activated, the 
selected channel connection is closed, the initialization parameters are re-read and the 
connection is re-established. Then, the database points and their addresses are re-read and, 
finally, the general status of all the tags on that channel is read. 

The SYNCHRONIZE button is used in channels with time correction. When activated, the date 
and time are sent to synchronize the clock on the client with the master clock. 

This window is divided in six smaller frames. These frames are reserved for (in a descending 
order): 

·  Last message sent to the channel; 

·  Interpretation by the driver of communication for this message; 

·  Last message received on this channel; 
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·  Interpretation by the driver of communication for this message; 

·  Channel status; 

·  Statistical communication information of this channel. 

At the bottom of the screen, the numbered squares represent the status of the communication 
channels. The meaning of each color is summarized in the table shown in the previous item – 
MESSAGE LIST. 

 

4.1.4.3 SPPCOMGTW.EXE log mechanism 

It is possible to activate a log generation mechanism to store the messages shown on the CM&I 
Gateway Interface while the SPPCOMGTW.EXE application is running. This file can be used to 
verify the messages sent and received during the operation in order to diagnose any failure. The 
log mechanism is optional, and it must be activated if so desired. 

To activate the log, set the ReportDevice parameter to value 1, in the REDE SPPCOMFG section 
of the project parameters file – see figure below. To open the project parameters settings window, 
select Tools -> Edit Project from the command menu. 

 

 
Figure 57 – Log mechanism activation. 

 

The generated files are stored in the Gateway-PC Logs subdirectory. For more details, see 
Section 2.2 - Directory Structure. The file name is: 

AVmmddhh.log 

Where: 

·  mm = month of the log generation (01 to 12); 

·  dd = day of the log generation (01 to 31); 

·  hh = time at which the SPPCOMGTW.EXE (01 to 24) was started. 

 

In order for a communication channel to have its information included in the log file, this channel’s 
LogReport parameter must be set with a value greater than 0. This attribute must be configured in 
the CANAL ‘n’ section, where n is the channel number in the project parameters file. To open the 
project parameters settings window, select Tools -> Edit Project from the command menu. 
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The LogReport parameter is a value between 0 and 127, equal to the total of the options 
selected. 

 

LOG REPORT 

Description  
Decimal 

Code 

Includes the information shown in the Data Statistics window. 64 

Includes the information shown in the Data Reception Status window. 32 

Includes the information shown in the Data Sending Status window. 16 

Includes the information shown in the Communication Status window. 8 

Reports the current channel communication status (0 = failure, 1 = OK); 4 

Includes the received messages (frame) in hexadecimal format 2 

Includes the sent messages (frame) in hexadecimal format 1 

 

For example, a communication channel set up with LogReport=7 (1+2+4) shows that the sent and 
received messages, and the current communication status will be included in the log file - see 
figure below. The default 0 value shows that a log file will not be generated to the channel. 

 

 
Figure 58 – Channel log file configuration. 

4.1.5 Event Viewer 

The CM&I Gateway Server has an events generation mechanism used to monitor  the 
applications running and to detect possible run failures. This information is generated when a 
specific set of processes is run within the applications. The events generated are saved in a text 
file named cmieventviewer.txt, stored in the Gateway-PC Logs  subdirectory (for details, see 
section 2.2 – Directory Structure) – see figure below. 
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Figure 59 - Utilities – Event Viewer. 

44..22  CCoonnff iigguurraatt iioonnss  
This item opens a window where the time and the Gateway-PC network can be configured – see 
figure below. 

 
Figure 60 - Gateway Server – Configurations. 

In the upper part of the window, there is a field where the current time on the Gateway-PC is 
shown. To change it, select a field and insert the desired time. The changes will be made after 
clicking the SAVE button. 
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The CM&I Gateway is configured with two network cards: one with a fixed IP (Eth0), and the other 
with user configurable IP (Eth1). The network card with fixed IP is used by the CM&I Gateway 
Client to establish a connection with the Gateway-PC. The second card is used to communicate 
with devices and applications, and may have its own IP address modified in order to include the 
Gateway-PC in an already configured network. To change this network card configuration, select 
the Eth1 tab and insert the desired values. The changes will be made after clicking the SAVE 
button. 

44..33  GGaatteewwaayy  RReessttoorree  
The CM&I Gateway Server has a tool named Gateway Restore, which allows the creation of 
project restoration points. When a restoration point is created, the Gateway Restore saves a 
folder with the default BACKUPyyyymmdd name in the Gateway-PC Backups subdirectory (for 
more details, see section 2.2 – Directory Structure). 

 

Where: 

·  yyyy = year in which the restoration point was created; 

·  mm = month in which the restoration point was created; 

·  dd = day on which the restoration point was created; 

Three items are saved in this folder: 

·  The project parameters file (.INI); 

·  The current project DBase directory, the folder in which the project database 
(BASEGTW.MDB) and the ACTION.UDL file are stored. 

·  The current Prg project directory, the folder in which the CM&I Gateway applications and 
libraries are stored. 

With these three items, it is possible to restore a project on the Gateway-PC, or to copy a project 
to a different Gateway-PC. 

4.3.1 Creating a restoration point 

To create a restoration point, open the Gateway Restore window and click on the BACKUP button 
– see figure below. 
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Figure 61 – Gateway Restore. 

Then enter the restoration point name in the opened window – figure below. The default name 
can be changed, if so desired. To finish, click OK. When the creation process is complete, the 
recently created restoration point name will be included in the Gateway Restore list. 

 
Figure 62 - Creating a restoration point 

4.3.2 Restoring a project image 

To restore a Gateway-PC image, select a restoration point from the list and click RESTORE. A 
window will ask for confirmation of the restore command – figure below. Click OK and the 
operation will be completed. 
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Figure 63 – Restoring a project with the Gateway Restore. 

 

 



 

  

55..  CCMM&&II  GGaatteewwaayy  CCll iieenntt   

The Gateway Client is used to establish a connection between any client computer 
and the Gateway-PC. When it is run, this application activates an icon which looks 
like a traffic light in the Windows Notification Area - see figure below, indicating the 
Gateway-PC status. 

 

 

Figure 64 - Gateway Client Icon in the Notification Area. 

 

The chart below summarizes what each symbol means: 

 

GATEWAY CLIENT  

Color  Meaning  

Red Communication with the Gateway-PC is OK, but the real time 
module (SPPCOMGTW.EXE) is not running. 

Yellow  It is not possible to establish communication with the Gateway-
PC. Check wiring and network settings. 

Green Communication with Gateway-PC is OK, and the real time 
module (SPPCOMGTW.EXE) is running. 

Right click on the Gateway Client icon, and a menu with the options Config 
Gateway, Show Gateway and Exit will open. See figure below. 

 

 

Figure 65 – Gateway Client options menu. 

Config Gateway 

This option opens a window from which it is possible to test the communication with 
the Gateway-PC and change the frequency the Gateway Client verifies the Gateway-
PC functioning. See figure below. 
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Figure 66 - Gateway Client – Gateway Config. 

As default, the IP gateway  field has the Gateway-PC IP address. However, it may be 
modified to test the client computer communication with other IP addresses. If the 
ping command receives a valid response, the IP gateway field background will turn 
green. If it does not receive a valid response, it will turn red. 

The Refresh rate  field shows the period, in seconds, between two successive 
Gateway-PC working status verifications. To change it, use the increase and 
decrease buttons, on the right. 

Show Gateway 

When selected, this option opens a session to access the Gateway Server interface 
running on the Gateway-PC. See figure below. 

 

 

Figure 67 - Gateway Client – Show Gateway. 
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Exit 

This option closes the Gateway Client and removes its icon from the Windows 
Notification area. If the Show Gateway session window is open, it will not close when 
you select this option. 

 



Communication Protocols 

  

66..  CCoommmmuunniiccaatt iioonn  PPrroottooccoollss  

66..11  DDEETTEECCTTOOMMAATT  
The AVDETECTOMGW.DLL module is used on the communication between the 
CM&I Gateway and the Detectomat fire control panels, models 3004 and 3016. 
Communication is done by the SERIAL channel, using the RS-232 interface. 

The DETECTOMAT communication module is implemented according to the FAT 
Message Protocol (Message Protocol of RS-232 for FAT - Fire Department 
Annunciator Panel). In order to allow this communication type, parameter 16 of the 
fire control panel – serial interface type – must be configured with value 3 (connect 
serial interface to FAT protocol) or 4 (FAT protocol with monitoring). 

6.1.1 Module Acronym 

To configure a communication channel with this protocol, select the DETECTOMAT 
acronym from the protocols list on the CM&I Gateway application CHANNELS 
window. 

6.1.2 Point Type 

The table below shows the point types and characteristics supported by the 
DETECTOMAT modules: 

 

Acronym  Code  Signal Type  Point Type  Point Description  

OSD 0 Digital Input Optical Smoke Detector 

HD 1 Digital Input Heat Detector 

MCP 2 Digital Input Manual Call Point 

SCU 3 Digital Input Sounder Control Unit 

IOM 4 Digital Input Input/Output Module 

AI 5 Analog Input Analog Input 

SYS 6 Digital Input System Status 

ZON 7 Digital Input Zone 

LOP 8 Digital Input Loop 

OUT 9 Digital Input Panel Output 

TCM 10 Digital Input Conventional Zone Module 

MUL 11 Digital Input Multisensor 

6.1.3 Point Addressing on CANAISPEC Table 

The Protocol, Group, Variable, Type, Address1 and Address 2 columns must be filled 
in during the point addressing process. 

On the Protocol column, the MODBUS communication module must be selected. The 
Group and Variable columns must be filled in with their corresponding group name 
and addressed tag variable name. The Description column, which might be left blank, 
may be used to register the point description. The Type column must be filled in with 
the register type. The item 6.2.2 – Point Types – describes the options for this field. 
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The filling in of the Address1 and Address2 fields varies according to the point type, 
and will be described in detail further on. The other columns are working parameters, 
and are not related to the addressing process. For more details about these fields, 
see item 4.1.3.2.1 – Commands Menu – File – Edit Tags. 

Configuration of Address1 and Address2 fields has to follow these steps: 

Address1  – This field must be filled in with the corresponding fire control panel 
address (IED’s address), regardless of the selected point type. 

Address2  – The configuration varies according to the selected point type. 

 

OSD, HD, MCP, SCU, IOM, TCM and MUL point types: 

These point types have an address within the fire control panel, with Zone and 
Detector fields. 

 

 
Figure 68 – Detector address format. 

 

The Address2 field must have 7 characters, with the following notation: 

1 The first 3 characters correspond to the detector zone; 

2 The fourth characters must be the delimiter ‘:’ (colon); 

3 The other 3 characters must indicate the detector position in that zone. 

Example: the temperature detector number 002, which belongs to fire control panel 
zone 005, and whose IED address is 2 must be addressed as follows: 

 
Figure 69 – Addressing an HD type point. 

 

The OSD, HD, MCP, SCU, IOM, TCM and MUL point types may have nine different 
statuses within the DETECTOMAT protocol. Each status is represented by a whole 
number. The list below is a summary of the possible status for these point types: 

 

Status 
Code 

Status Description  

0 Off 

1 On / Normal 
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2 Alarm 

3 S60 Alarm 

4 Failure 

5 Pre-alarm  

6 Test alarm 

7 Technical Failure 

8 Acknowledgement (after alarm) 

 

 

The figure below shows a failure point (status code = 4) on the CM&I Gateway 
Interface STATUS window: 

 

 

Figure 70 – Failure point shown on the CM&I Gateway Interface. 

 

 

b) Al type point 

This type of point includes the analog variables that may be read from the fire control 
panel. The table below shows the referred variables connection and their 
corresponding addresses: 

 

 

Address2  Description  

1 Number of trouble messages 

2 Number of disconnected zones 
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3 Day of the month 

4 Month 

5 Year 

6 Time 

7 Minute 

8 Bitbus Address 

 

The figure below is an example of how the Month variable addressing should be 
done when read from the date message sent by the panel: 

 

Figure 71 – Addressing an analog point. 

 

c) SYS type point 

This category of points groups the variables related to the trouble messages and to 
the switch on/switch off variable messages used to describe the panel status. The 
table below shows the accessible system variables and their corresponding 
addresses: 

 

Address2  Variable Description  Possible 
Status  Status Description  

1 Panel Communication 
Status 

0 Initiating Communication 

1 Normal 

2 Failure 

2 AC Failure 
0 Normal 

1 Failure 

3 Battery 
0 Normal 

1 Failure 

4 External 24V 
0 Normal 

1 Failure 

5 Bitbus 
0 Normal 

1 Failure 

6 Eprom 
0 Normal 

1 Failure 

7 Internal Sounder 
0 Normal 

1 Failure 

8 RAM Checksum 
0 Normal 

1 Failure 

9 RS-232 0 Normal 
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1 Failure 

10 Main CPU 
0 Normal 

1 Failure 

11 Controller 
0 Normal 

1 Failure 

12 Shield 
0 Normal 

1 Failure 

13 DLI 3000 
0 Normal 

1 Failure 

14 Delay 
0 Off 

1 On 

15 Revision 
0 Off 

1 On 

16 Door Contact 
0 Open 

1 Closed 

17 Fire Sequence Control 
0 Off 

1 On 

18 Fuse Control Loop 
0 Normal 

1 Failure 

19 FBKDB Alarm 
0 Deactivated 

1 Activated 

20 FBKDB Unlocked 
0 Deactivated 

1 Activated 

21 Call Fire Department 
0 Deactivated 

1 Activated 

22 Main Alarm 
0 Deactivated 

1 Activated 

23 Reset 
0 Deactivated 

1 Activated 

24 Releasing System 
Activated 

0 Deactivated 

1 Activated 

25 Output to Fire 
Department activated 

0 Deactivated 

1 Activated 

26 Audible Disable 
0 Deactivated 

1 Activated 

27 
Fire Alarm Sequence 

Control 

0 Deactivated 

1 Activated 

28 Output to Fire 0 Deactivated 
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Department Disable 
1 Activated 

29 Detector Module 01 
0 Normal 

1 Failure 

30 Detector Module 02 
0 Normal 

1 Failure 

31 Trouble Outputs 
0 Off 

1 On 

32 Maintenance 
0 Off 

1 On 

33 Output 1 
0 Normal 

1 Failure 

34 Output 2 
0 Normal 

1 Failure 

35 Output 3 
0 Normal 

1 Failure 

36 Fuse Output 1 
0 Normal 

1 Failure 

37 Fuse Output 2 
0 Normal 

1 Failure 

38 Fuse Output 3 
0 Normal 

1 Failure 

39 Relay Output 
0 Off 

1 On 

40 Fire Department Output 
0 Normal 

1 Failure 

 

The figure below shows how the addressing of the Panel Communication Status 
parameter is done: 

 

 
Figure 71 – Addressing a SYS type point. 

 

 

 

d) ZON type point 

According to the model, a fire control panel may have 128 or 192 detector zones. 
ZON type variables report zone errors, if any. If all the points on this zone are normal, 
the ZON variable status will be NORMAL (0). However, if at least one detector is not 
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on normal status, the ZON variable will change to the FAILURE (1) status. This point 
type is addressed by attributing the zone number (1 to 192) to the Address2 field. 

e) Type LOP point 

Depending on the loop boards model and number, a Detectomat fire control panel 
may have up to 16 detector loops. When a loop has an error, the fire control panel 
generates a message to report it. The LOP variable indicates if the detectors loop 
status is NORMAL (0) or FAILURE (1). This point type is addressed by attributing the 
loop number (1 to 16) to the Address2 field. 

f) OUT type point 

A Detectomat fire control panel has outputs that may be used to activate external 
devices. The OUT type variable records if a certain output is OFF (0) or ON (1). This 
type is addressed by attributing the output number (1 to 16) to the Address2 field. 

 

6.1.4 DETECTOMAT Channel Configuration 

The DETECTOMAT communication module uses the SERIAL type communication to 
send and receive data. On the channel configuration window, GENERAL tab, the 
Type and Protocol fields must be filled in as shown in the figure below: 
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Figure 72 - DETECTOMAT channel configuration. 

 

On the SERIAL configuration tab, the parameters must be adjusted as follows: 

 

 

 

Figure 73 - Serial communication attributes definition. 

 

·  Setting = 9600,n,8,1 

·  Port = Serial port to which the panel is connected. 

·  Slave Port = None 

·  Flow control = None 

·  RTS OnDelay (ms) = 0 

·  RTS OnDelay (ms) = 0 

 

6.1.5 DETECTOMAT Devices Configuration 

After creating a DETECTOMAT channel, you must add a device (IED) to the fire 
control panel connected to the channel. The window below is used to configure the 
IED: 
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Figure 74 - DETECTOMAT Devices Configuration. 

 

The window fields are described below: 

·  IED Address: Must contain the panel address within the CM&I Gateway 
database. 

·  IED Description: might Optional, Can be used to record the panel 
identification. 

·  Timeout IED: To be filled in with the time interval, in milliseconds, that the 
CM&I Gateway will wait before reporting a communication failure with the 
panel, in case no message is received. 

·  Bitbus Address: Contains the corresponding panel Bitbus address. 

CAUTION: If there is no event (alarms, failures, etc.), the panel will send a message 
with the date and time at every minute. Because of that, it is recommended that the 
Timeout IED parameter has a value greater than 60s, in order to avoid the generation 
of unnecessary alarms due to communication failure. 
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6.2 MODBUS 
The AVMODBUSG.DLL module is used for the communication between the CM&I 
Gateway and the data acquisition devices that use the MODBUS protocol. The 
communication may occur through a multipoint serial channel, or using the Ethernet 
local network and the TCP-IP protocol. 

The MODBUS protocol supports register reading and writing. The messages may be 
in the Modbus-RTU or Modbus ASCII formats. 

During register reading, the read value can be converted into a different data format 
than the original, such as real, whole number, long whole number, bit, etc. The 
simple write functions are used to send high level commands from the CM&I 
Gateway. 

The function used by the MODBUS communication module to manipulate registers 
depends on the type of point configured on the CM&I Gateway database. The 
available read/write functions are: 

·  0x01 Read Coil Status (Read Output Status); 

·  0x02 Read Input Status; 

·  0x03 Read Holding Register; 

·  0x04 Read Input Register; 

·  0x05 Force Single Coil; 

·  0x06 Preset Single Register; 

·  0x10 Preset Multiple Registers. 

 

Two modes of operation are available for this communication module: MASTER 
mode and SLAVE mode. In MASTER mode, the communication module runs 
actively, sending read requests and write commands within registers to slave 
devices. This operational mode is typically used by the CM&I Gateway to acquire 
field equipment data. 

In SLAVE mode, the communication module runs passively, waiting to receive read 
requests or write commands sent by a master device, such as the SCADA software, 
for example. This mode of operation must be selected when the CM&I Gateway has 
to convert from an origin protocol (Detectomat, for example) to the MODBUS 
protocol. 

When a read request is received, the CM&I Gateway sends a response with the 
register value/status requested. When it receives write commands, the CM&I 
Gateway runs the necessary operations on the indicated registers. 

 

6.2.1 Module Acronym 

To configure a communication channel with this protocol, select the DETECTOMAT 
acronym from the protocols list on the CM&I Gateway application CHANNELS 
window. 
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6.2.2 Point Type 

The MODBUS communication module has a set of point types defined according to 
the data format (bit, whole, float, etc.), register type (input or output), and function 
used for reading/writing. 

Each MODBUS record must be addressed in the database with the appropriate type 
of point, according to its characteristics. The table below shows the point types 
available for this communication module: 

 

Module  Code  Acronym  Analog/ 
Digital  Type*  Description / Function Used  

MODBUS 0 OS D I Output Status – Bits 

MODBUS 1 IS D I Input Status – Bits 

MODBUS 3 IR A I Input Register – 16 bit Word 

MODBUS 4 OR A I Output Register – 16 bit Word 

MODBUS 6 SY D I System Points (communication) 

MODBUS 13 SIR A I Input Register – Signed 

MODBUS 14 SOR A I Output Register – Signed 

MODBUS 23 FIR A I Input Register – Float (2 Words ) 

MODBUS 24 FOR A I Output Register – Float (2Words) 

MODBUS 43 DIR A I Input Register – double (4 Words) 

MODBUS 44 DOR A I Output Register – double (4 Words) 

MODBUS 53 LIR A I Input Register – Long (32 bits Whole ) 

MODBUS 54 LOR A I Output Register – Long (32 Bits whole 
) 

MODBUS 63 BIR D I Input Register – Access to Bits 

MODBUS 64 BOR D I Output Register – Access to Bits 

MODBUS 7 SD D O Preset Single Register (digital output in 
16 bits register) 

MODBUS 9 SA A O Preset Single Register (analog output, 
16 bits whole) 

MODBUS 5 EV D I Special Events Treatment WITH status 
change in the database 

MODBUS 8 EVX D I 
Special Events Treatment 
WITHOUT status change in the 
database 

MODBUS 65 SFC D O 
Force Single Coil – digital output in 
one bit, according to parameter  

*Column Type: I = Input point; O = Output point. 

 

 

6.2.3 Point Type Characteristics 

The following table shows the main characteristics of each point type mentioned on 
the previous item: 
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Acron

ym  Address2  Format  Reading Function  

OS <bit reference> Bit Read Output Status 

IS <bit reference> Bit Read Input Status 

IR <register>:<bit field> 16bit Word – without 
signal Read Input Register 

OR <register>:<bit field> 16bit Word – without 
signal Read Output Register 

SY 1 Internal digital point System Points (communication) 

SIR <register> 16bit Word – w/ signal Read Input Register 

SOR <register> 16bit Word – w/ signal Read Output Register 

FIR <register> Float (IEEE) 32 bits Read Input Register 

FOR <register> Float (IEEE) 32 bits Read Output Register 

DIR <register> Double Float 64 bits Read Input Register 

DOR <register> Double Float 64 bits Read Output Register 

LIR <register> Long Integer 32 bits Read Input Register 

LOR <register> Long Integer 32 bits Read Output Register 

BIR <register>:<n bit> Bit Read Input Register 

BOR <register>:<n bit> Bit Read Output Register 

SD <register> 16 Bit Word 

Preset Single Register (digital output). 
The value sent is the Output Parameter 
field value for the selected point in the 
database. 

SA <register> 16 Bit Word 
Preset Single Register (Analog Output 
or set point). The value sent is the 
current existing output variable value. 

SFC <bit reference> Bit 

Force Single Coil - Sends a Modbus 
ON or OFF code, which must be in the 
output Parameter field, in the CM&I 
Gateway database 

EV <Number> 
Adds events and 

changes the status on 
the database 

Special Events Treatment for each type 
of slave Device. (See description 
below) 

EVX <Number> 
Adds events without 
changing the status 

on the database 

Special Events Treatment for each type 
of slave Device. (See description 
below) 

 

The first column shows the type of point, as specified in the TipoPontos table. 

The second column shows the Address2 field specification format on the CanaisPec 
table. 

The third column shows the format which will be associated to the read registers. For 
example, if a point is defined as Float (FOR) after reading the 16 Bits registers to 
create the point value, the 4 bytes from the register address will be considered in the 
IEEE-866 representation. 

The last column shows the MODBUS function to be used in the reading or writing 
operation. 
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6.2.4 Point addressing on CANAISPEC table 

The points on the CanaisPEC tags table must be addressed as follows: 

 

 

 

Figure 75 - MODBUS point addressing - Slave mode. 

 

The Protocol, Group, Variable, Type, Address1 and Address 2 columns must be filled 
in during the point addressing process. 

In the Protocol column, select the MODBUS communication module. The Group and 
Variable columns must be filled in with their corresponding group name and 
addressed tag variable name. The Description column, which is optional, may be 
used to register the description of the point. The Type column must be filled in with 
the type of register. Item 6.2.2 – Point Types – describes the options for this field. 

The filling in of the Address1 and Address2 fields varies according to the operation 
mode, master or slave, and will be described in detail further on. The other columns 
are working parameters, and are not related to the addressing process. For more 
details about these fields, see item 4.1.3.2.1 – Commands Menu – File – Edit Tags. 

 

6.2.4.1 MASTER mode 

Address1 - Has the format <address UTR>:<Reading Group number>. 

The first number is the Modbus slave device (IED) physical address, and is unique to 
all the existing devices in an installation, even if connected to different 
communication channels. It must be between 1 and 255. The second field is the 
specified reading block number. For example: the notation "1:2" shows equipment 
with physical address 1 and reading group number 2. 

Reading Group 

As MODBUS protocol default, the reading of sets of registers is done by using data 
blocks with limited size. This operation requires that all the registers read in a single 
request use the same read function. These registers are also required to be stored at 
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consecutive addresses. The set of points that meet these requirements is named a 
Read Block. 

The CM&I Gateway supports 10 read blocks (0 to 9) by device (IED). A read block 
may have points in different formats (whole, float, long, etc.), provided all of them can 
be accessed by the same function (Read Holding, Read Input Registers, etc.). 

CAUTION: The points whose types specify bits in whole registers (BIR or BOR) must 
be in different blocks from the ones used to read numbers in float, whole or double 
format. 

A read group supports 250 data bytes. As a result, it may contain up to 125 registers 
of 16 bits. To calculate the number of registers that can be added to a same read 
block, see item 6.2.3 - Point type characteristics - to verify the number of bits 
required for each register. 

CAUTION: Ensure the set of points added to a same read block does not exceed 250 
bytes. 

If you do not specify the read block number, the register will be automatically added 
to the number 0 read block. 

 

Address2  - It is the point address within the Modbus slave device (IED). It shows the 
register address which must be accessed within the IED. It may be in decimal or 
hexadecimal format. To specify in hexadecimal format, include the "H" character after 
the register number. For example, the address 16 in hexadecimal format would be: 
10H. 

Find below the special Address2 field addressing formats description: 

<bit reference> 

For the specific case of status points (type IS or OS), use the <bit reference >, which 
can be only one number, decimal or hexadecimal, to indicate the bit position. 

It is possible to obtain the reference from the pair: <initial bit address>:<bit order 
number>, of this initial address. 

 

<register>:<bit number> 

For references to bits in whole registers (BOR or BIR type), use the pair: <register 
address>:<bit number>. The <bit number> must be between 0 and 15, where 0 is the 
less significant register bit. This field must always be in decimal format. The register 
address (Address2) must be between 0 and 65535. 

  

Bits field <bit number>:<number of bits > 

To specify bits fields in whole registers (OR or IR type), use: <register address>:<bit 
number>:<number of bits>. 

The <register address> (Address2) must be between 0 and 65535. The <bit number> 
must be between 0 and 15, where 0 is the less significant register bit. This field must 
always be in decimal format. The <number of bits> counting is done from the most 
significant to the least significant bit of the field. If the field has only one bit, it is not 
necessary to specify the number of bits. Examples: 

Address2 = “2108:5” – Shows the number 5 bit of register 2108; 
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Address2 = “E3H:6:2” – Shows the 2 bits field from bit 6 (therefore, bit 6 and 5) of 
register E3 (hexadecimal). 

 

Points for indication of Communication Failure 

The MODBUS protocol has a type of point to identify communication failure 
(timeouts) with MODBUS slave equipment. This type of point, named "system point", 
has the acronym "SY" and code 6. They must be addressed in the following format: 

1 Address1 = Monitored equipment address (UTR); 

2 Address2 = 1 (always). 

 

6.2.4.2 Slave Mode 

In slave mode, the communication module is passive. The protocol only responds to 
the read requests and to the received write commands. In this mode, the messages 
are also limited to 250 bytes (or 125 data registers). 

The CanaisPEC table configuration is similar to the configuration in master mode. 
However, it is not necessary to indicate read blocks in the Address1 field. Thus, the 
configuration should be: 

Address1 - Indicates a Modbus slave device (IED) address created by the Gateway-
PC to aggregate the points to be served. This address must be unique amongst all 
the existing devices on an installation, even if connected to different communication 
channels. The IED number must be between 1 and 255. 

Address2  - This is the point address within the Modbus slave device (IED). It 
indicates the register address at which data is stored within the Gateway-PC.  

 

When a read request is received, the communication module will look for the 
requested referred points in the CanaisPec table, according to the Modbus function 
used. It searches for the variables with Address1 equal to the slave IED address 
requested. Then, it searches for variables according to the received register address 
and point type. The following table shows this correspondence. 

 

Function received on the request Point Types Searched  

01h Read Coil Status (Read Output Status); OS 

02h Read Input Status IS 

03h Read Holding Register; OR, SOR, FOR, LOR, BIR 

04h Read Input Register IR, SIR, FIR, LIR, BIR 

 

The current point value is sent back in the CanaisPec table specified format: 

·  Status - One bit each; 

·  IR, OR, BIR and BOR registers - 2 bytes; 

·  SIR and SOR – Whole with 16 bits signal; 

·  FIR and FOR – IEEE-866 float format , 4 bytes; 

·  LIR and LOR – Whole with 32 bits. 
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When the first point referred to in a read request is not found, the response will be a 
Modbus Exception : in the response, the most significant bit of the Function  byte 
will be 01h, and the following byte will be an error. In this case, the error will be: 02h 
– ILLEGAL DATA ADDRESS. 

If the CM&I Gateway does not find the referred points within a read request block, 
these points will be added with zero value in a normal response. No error will be 
indicated. 

The register write functions supported by the slave mode are: 

·  05h Force Single Coil; 

·  06h Preset Single Register; 

After receiving such requests, the communication module searches CanaisPec table 
for the output variables configured with the addresses specified in the command 
request. When they are found, it executes the command request using the Output 
Parameter specified in the CanaisPec table for each variable. 

The table below shows the correspondence used. 

 

Writing Function  Searched 
Types  

Information for the 
Command  

Sent Value  

05h Force Single Coil; SFC Output Parameter -- 

06h Preset Single Register 

SD Output Parameter -- 

SA Output Parameter Current output point 
value 
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6.2.5 Configuring a Specific Modbus Channel Tab 

  

 
Figure 76 - Configuring a Specific Modbus Channel Tab. 

 

 

Station Mode  - Channel operation mode. The MASTER mode must be selected 
when the channel is used to acquire Modbus equipment data. The SLAVE mode 
must be selected when the Gateway-PC is used to provide data in the Modbus 
protocol. 

Transmission Mode  - Transmission type used by the protocol: RTU, the data are 
transmitted in binary code; ASCII, the codes are transmitted in ASCII code. 

Open Modbus  - Select this mode if the message is transmitted in OpenModbus 
format.  

Timeout  - Time interval, in milliseconds, that the communication module will wait 
before reporting an error condition. If no message is received within the Timeout 
interval, a new read/write request will be sent and a counter will start to monitor the 
number of send attempts. This procedure will be repeated until one of the following 
options is satisfied: 
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·  a response is received; 
·  the counter reaches its limit, represented by the MaxRetry  parameter – 

maximum number of send attempts. 

When the second option is satisfied, the communication channel will change its 
status to CHANNEL FAILURE. When either of these options is satisfied, the counter 
will be reset to zero. 

MaxRetry  - Number of consecutive attempts to resend the same message to a piece 
of slave equipment which did not respond within the timeout interval. After these 
attempts, a Communication Failure event will be generated.  

When a Modbus channel is configured in MASTER mode, a set of fields will be 
opened to configure the read block parameters. 

 
Figure 77 - Master mode configuration - Read groups. 

 

Sampling Block  - Indicates the number of the read group being configured. 

IS Sampling  - Frequency with which the IS (Input Status) point type read block 
requests are sent. Value 0 indicates they will never be read. They also will not be 
read if no point of such type is found in the database. 
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OS Sampling  - Frequency with which the OS (Output Status) type of point reading 
block requests are sent. Value 0 indicates they will never read. They also will not 
read if no point of such type is found in the database. 

IR Sampling  - Frequency with which the read requests of Blocks of Points read via 
ReadInputRegister, IR, SIR, FIR, DIR, LIR or BIR (InputRegisters) types are sent. 
BIR type of points must be specified in separate groups. The frequency is the same 
for all the blocks. Value 0 indicates they will never read. They also will not read if no 
point of such type is found in the database. 

OR Sampling  - Frequency with which the read requests of Blocks of Points read via 
ReadOutputRegister, OR, SOR, FOR, DOR, LOR or BOR (Output or Holding 
Registers) types are sent. BIR type of points must be specified in separate groups. 
The frequency is the same for all the blocks. Value 0 indicates they shall never be 
read. They also will not read if no point of such type is found in the database. 

 

6.2.6 Configuring a Modbus IED 

To configure a Modbus channel IED, use the Devices properties window, accessible 
from the objects tree in the CM&I Gateway Interface. In this window, the device 
Modbus address and the data bytes transmission order can be defined and an 
identification can be added to the IED. 

 

 
Figure 78 - Configuring a Modbus IED. 
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IED Address  - Used to identify the Modbus device (IED) address, being unique to all 
the existing devices in an installation, even if connected to different communication 
channels. It must be between 1 and 255. 

IED Description  

Floating Poin t – Defines the mode of sending values in float format. Direct Order 
shows that the most significant bytes will be sent first. Indirect Order shows that the 
first register transmitted is the least significant. 

Long Integers  – Defines the mode of sending of long format values. Direct Order 
shows that the most significant bytes will be sent first. Indirect Order shows that the 
first register transmitted is the least significant. 

Bytes in Words (16 bits)  – Specifies the mode of sending in word format (16bits). 
Direct Order shows that the most significant bytes will be sent first. Indirect Order 
shows that the first register transmitted is the least significant. 

 

6.3 OPC 

6.3.1 OPC - OLE for Process Control - OPC Server 

The CM&I Gateway includes an OPC Data Access Server, compatible with versions 
1.0 and 2.0. The OPC server program is owned by Tecnosoftware AG. Its distribution 
is licensed to Ruhcon Inc., author of the DLL AVOPCSRV.DLL, which makes the 
interface between the OPC server and the CM&I Gateway real time database. 

During the installation of the CM&I Gateway, register the OPC Server with the name 
SpinGateOpcServerDA . For each project created on the Gateway-PC, a registration 
file is created on the OPC server. Registration may also be done from the CM&I 
Gateway commands menu, on the Tools -> Register Application item. 

To use the OPC Server which is available on the CM&I Gateway, the OPC client just 
has to connect to the OPC server registered on the target computer. After the 
connection is established, all the existing points on the CM&I Gateway Runtime 
(SPPCOMGTW.EXE) real time table will be available to the client from the 
SpinGateOpcServerDA  OPC server. 

If the CM&I Gateway Runtime is not active when the attempt to connect the OPC 
client is made, the OPC server will automatically start CM&I Gateway Runtime, using 
the project file defined during the OPC server registration. 

For this protocol, it is not necessary to register channels, devices or points, as all the 
existing points on the Gateway-PC are available on the OPC server. 

The figure below shows an OPC client application connection configuration window. 
When this application is started, it identifies all the OPC servers registered on the 
computer. This window shows how the CM&I Gateway OPC server is seen from an 
OPC client. 
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Figure 79 - CM&I Gateway OPC Server seen by an OPC client. 

 

After they are connected, all the other protocols available on the project running on 
the CM&I Gateway are added to the OPC server. To access these points, just add 
the desired items to a reading group. 

 
Figure 80 - Adding items to an OPC client group. 
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After adding items, the OPC server starts reading the Gateway CM&I points 
information in real time, and then shows the received data: 

 
Figure 81 - Gateway CM&I points shown on an OPC client. 

 

6.3.2 OPC Readings 

When the OPC client requests to read, the current Gateway-PC point values are 
sent. The reading is accepted only for points whose type input or internal. 

For analog points, values are sent in the Float (IEEE-32 bits) format, and for digital 
points, points are sent in the whole format (16 bits). 

Regardless the type of point, the timestamp attributed by the OPC client during a 
reading corresponds to the Gateway-PC existing timestamp for that point. 

6.3.3 OPC Writing 

With the writing or telecommunication commands sent by OPC clients to the 
Gateway-PC, Boolean values, whole values (16 or 32 bits) and Float values (32 or 64 
bits) are accepted. 

After receiving a command, a point whose type attributed on the Gateway-PC 
database is internal has its value modified in the Gateway-PC database, and it does 
not generate an output command. 

However, when output points receive a command, they have their values modified in 
the database and they generate a command which is sent to the corresponding 
communication module. The value sent during an OPC writing procedure is sent to 
the commanded point communication module, which will use it as an Output 
Parameter. 

The input points are not modified. The OPC writing command attempt is replied to 
with the OPC_E_BADRIGHTS error code. 

6.3.4 OPC Server Registration File 

The OPC Server registration is usually done during the installation process, but it 
may also be done from the CM&I Gateway commands menu, in the Tools -> Register 
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Application item. The registration file is named RegOpcServXXX.bat , where XXX is 
the project file name. 

When you create a new project or modify a program directory, a new registration file 
is generated with the directory paths and with the appropriate project names. 

6.4 BACnet (MS/TP or IP) 

6.4.1 Module Code 

The AVBACNETG.DLL module is used for communication between the CM&I 
Gateway and intelligent electronic devices (IEDs) which use either BACNet MS/TP 
(Master-Slave/Token Passing) protocol or BACnet IP protocol. 

The communication with BACnet MS/TP devices is established via the multipoint 
SERIAL channel, using a RS-232/RS-485 or a USB/RS485 converter, while BACnet 
IP communication is established over Ethernet networks using the UDP-IP protocol. 

Serial communication with BACnet devices from the m anufacturer Delta 
Controls  must be set up using the Delta Controls  CON-768 RS-232/RS-485 
signal converter. 

6.4.2 Types of Points  

The current functions available on the BACnet protocol are: 

·  Reading: Inputs, outputs, internal variables (setpoints), date/time, schedulers 
and variables that describe the communication status with the controllers; 

·  Sending commands to: internal variables, outputs and date/time (time 
synchronization); 

·  Reading and writing from the controller Weekly Calendar Table to pre-
program the scheduler actions (time schedule). 

The types of points supported by this protocol are: 

 

Acronym Code Signal Type Point Type Point function 

VEA 0 Analog Input Reading of internal variables declared as 
analog. 

VED 1 Digital Input Reading of internal variables declared as 
digital. 

VSA 2 Analog Output Writing of internal variables declared as 
analog. 

VSD 3 Digital Output Writing of internal variables declared as 
digital. 

IEA 4 Analog Input Reading of input points declared as analog. 

IED 5 Digital Input Reading of input points declared as digital. 

OEA 6 Analog Input Reading of output points declared as analog. 

OED 7 Digital Input Reading of output points declared as digital. 

OSA 8 Analog Output Writing of output points declared as analog. 

OSD 9 Digital Output Writing of output points declared as digital. 

TIM 10 Analog Input Date/time reading points. 
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SCH 11 Digital Input Current value of the weekly time schedule. 

WEK 12 Analog Output Weekly time schedule. 

SYS 13 Digital Internal Communication failure indication. 

 

6.4.3 Acronyms Description 

All the acronyms (except TIM, SCH, WEK and SYS) follow the terminology according 
to its function on the IED. The first letter corresponds to the point destination: INPUT, 
OUTPUT or VARIABLE. 

VSD 

The two last letters correspond to the variable type on the IED and its use in the 
database: 

·  EA – Analog Inputs. Variables configured as analog on the IEDs to be 
monitored by the software. 

·  ED – Digital Input. Variables configured as digital on the IEDs to be monitored 
by the software. 

·  SA – Analog Output. Variables configured as analog outputs on the IEDs to 
be commanded by the user. 

·  SD – Digital Output. Variables configured as digital outputs on the IEDs to be 
commanded by the user. 

 

6.4.4 Point Addressing 

·  Address1  - The IED address, which identifies the BACnet device a point 
belongs to. This information is related to the gateway database and should 
not be confused with the physical address. It must be between 1 and 65535. 

·  Address2  - The point address configured on the IED, except for the TIM and 
SYS type variables, which follow specific criteria. 

 

6.4.4.1 TIM type points 

These are points referring to the IED date and time reading. They are addressed 
according to the indexes in the table below: 

 
Address 2 Function 

1 Day of the Month Reading 

2 Month Reading 

3 Year Reading 

4 Time Reading 

5 Minute Reading 

6 Seconds Reading 

7 Day of the Week Reading 
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6.4.4.2 SYS type point 

To signal a communication failure between the workstation and a specific IED, a SYS 
type digital or internal multiple digital variable has to be created, where: 

·  Address1 = IED Address; 

·  Address2 = 1. 

 

If the variable status equals 0, this corresponds to normal communication; if the 
variable status equals 1, it corresponds to a communication failure. 

 

6.4.4.3 SCH type points 

They are points related to the reading of internal IED variables (scheduler), whose 
current values are calculated internally by the device itself, in accordance with the 
specifications of a weekly time schedule. There is an independent time schedule to 
each scheduler.  

For example, an IED may have four SCH (scheduler) type variables, which may have 
value 0 (false) or 1 (true), or another analog value. 

An SCH type variable is used, for example, to execute commands at a pre-scheduled 
time. Thus, if digital output variables are associated to an SCH type variable which 
assumes the values below, during the week the equipment associated with these 
digital outputs will be switched on and off, as the variable takes the values 0 (zero) 
and 1 (one), respectively. 

 

Monday  Tuesday  Wednesday  Thursday  Friday  Saturday  Sunday  

Time Value Time Value Time Value Time 
Valu

e Time Value Time Value Tim Value 

8am 1 8am 1 8am 1 8am 1 8am 1 8am 1 8am 1 

12pm 0 12pm 0 12pm 0 12pm 0 12pm 0 12pm 0 12pm 0 

1:30pm 1 1:30pm 1 
1:30p

m 1 1:30pm 1 1:30pm 1 1:30pm 1 
1:30p

m 1 

6pm 0 6pm 0 6pm 0 6pm 0 6pm 0 6pm 0 6pm 0 

 

 

6.4.4.4 Analog Output Points 

The analog output points have the same address as their corresponding input, 
however different type. 

Example: 

To read the current value of the “Output 1” of an IED, which is set as an analog 
output, a point will be addressed: 

OEA, address2 = 1. 

To command this same output, a point will be addressed: 

OSA, address2 = 1. 

For further information, please refer to the sections: “Priorities Array” and “Sending 
Commands”.  
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6.4.4.5 Digital Output Points 

The digital output points have the same address as their corresponding input, 
however different type. 

Example: 

To read the current value of the “Output 2” of an IED, which is set as a digital output, 
a point will be addressed: 

OED, address2 = 2. 

To command this same variable, a point will be addressed: 

OSD, address2 = 2 

For further information, please refer to the sections: “Priorities Array” and “Sending 
Commands”.  

 

6.4.5 BACnet channel parameters configuration 

The following figure shows the tab with the parameters to configure a channel with 
the BACNet protocol. The BACnet protocol to be used is automatically set according 
to the channel type selected: 

·  SERIAL = BACnet MS/TP; 

·  NETWORK = BACnet IP. 
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Figure 82 - Configuring a BACnet Channel. 

 

Computer Address 

Computer address on the BACNet MS/TP network. There should not be 
another element on the network with the same address. The default 
Computer Address is 1. 

This parameter must be set 1 when communicating wit h BACnet 
MS/TP devices from the manufacturer Delta Controls . 

Number of Attempts 

Corresponds to the number of attempts to send the same command 
message to the IED, when the expected response does not come within the 
time period specified by the Time-out  parameter. After these attempts, a 
Communication Failure event will be generated. 

Calendar Sample Time 

Period of time, in minutes, between sending two consecutive calendar 
adjustment requests (adjusts the IED time to synchronize with the computer 
time). Value = 0 indicates it should never be sent. 

Thus, the protocol will normally synchronize the controllers with the 
computer where the protocol is running. 
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Time-out 

Maximum period of time, in seconds, that the communication module waits 
for a response to a reading request sent to the IED. After this time, it tries to 
resend the same request. 

Default command priority 

BACnet command priority value sent on command messages when no 
priority information is given. For further information, please refer to the 
sections: “Priorities Array” and “Sending Commands”.  

 

6.4.6 BACnet IED Configuration 

The window shown below is used to configure the parameter of each of the IEDs. 

In the IED configuration, the reading time for each group of variables can be selected 
or the reading of certain groups can be configured not to be done, if the internal 
variables of these groups are not used in this application, thus making 
communication between the workstation and the IEDs faster. 

Whenever the reading time field has a 0 value, this field will not be read. 

 
Figure 83 - Configuring a BACnet IED. 
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IED Address 

Used to identify the BACnet device (IED) address, being unique to all the 
existing BACnet devices in a gateway project, even if connected to different 
communication channels. It must be between 1 and 65535.  

IED Description 

Optional use, for documentation purposes. 

DIP Switch Address 

Specifies this IED physical address, which is usually assigned via a DIP 
switch.  

There must not be other device with identical physi cal address on the 
same BACnet network. 

Subnet 

Indicates if a BACnet IED has its Device Object value different from its 
physical address and/or if it uses Network Layer related services, therefore 
demanding the address of the BACnet network in which this IED is 
connected to. 

Used only with Delta Controls  equipment. It should be set ACTIVE on the 
following situations:  

·  Application Controllers configured as SYSTEM (DNA jumper active); 

·  System Controllers configured as SYSTEM (no matter the DNA 
jumper position). 

 

Network Address 

Address of the BACnet network in which this IED is connected to. Present 
only if Subnet = ACTIVE.  

Used only with Delta Controls  equipment. The System Controller which 
determines the BACnet network address of the Application Controllers must 
have its network address = 0.  

Device Object Id 

BACnet Device Object value of this IED. Present only if Subnet = ACTIVE.  

Used only with Delta Controls  equipment. 

Inputs 

Period of time, in milliseconds, between sending two consecutive read 
requests of inputs. Value = 0 informs that this message should never be 
sent. 

Outputs 

Period of time, in milliseconds, between sending two consecutive read 
requests of outputs. Value = 0 informs that this message should never be 
sent. 

Schedule 

Period of time, in milliseconds, between sending two consecutive read 
requests of the current value of the schedulers (existing time schedules in 
IEDs). Value = 0 informs that this message should never be sent. 
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Time Variables 

Period of time, in milliseconds, between sending two consecutive date/time 
read requests. Value = 0 informs that this message should never be sent. 

Analog Variables 

Period of time, in milliseconds, between sending two consecutive read 
requests of analog variables. Value = 0 informs that this message should 
never be sent. 

Digital Variables 

Period of time, in milliseconds, between sending two consecutive read 
requests of digital variables. Value = 0 informs that this message should 
never be sent. 

All Objects 

Period of time, in milliseconds, between sending two consecutive read 
requests of all IED points at once, regardless of their types. This read 
request returns the value of all inputs, outputs, variables, schedulers, and 
also the current time/date. Value = 0 informs that this message should never 
be sent. 

 

6.4.7 Priorities Array 

The BACNet protocol has the peculiarity of having a priority array to determine the 
current value of an output point or an internal variable (optional), either analog or 
digital. 

The priority array consists of a table of values commanded in descending order of 
priority. The first value on the table corresponds to priority 1 (the highest); the second 
corresponds to priority 2, and so forth, up to the sixteenth value, which corresponds 
to priority 16 (the lowest). 

Each value in the table must contain a command value or be NULL. A NULL value 
indicates there is no command for that priority. An internal IED mechanism 
continuously monitors the priorities array of each output and variable in order to 
specify the value of the highest priority other than NULL, and to put it at the output 
point. 

This way, each command sent to a BACnet IED has its specific priority, defined by 
the user, and the value sent on this command is assigned to the corresponding 
position in the priority array. The selection of most priorities depends on the 
application. The BACnet rule contains some default priorities (see table below). Other 
applications needing a priority are the Temperature Override, Demand Limiting, 
Optimum Start/Stop, Duty Cycling, and Scheduling. The priorities relating to these 
applications vary in accordance with the plant, and do not have a standard. In order 
to operate within in a particular system, the only requirement is that all the devices 
have the same priority. The positions marked as Available on the table are to be 
assigned by the programmers. The interpretation of which conditions are of Manual-
Life Safety or Automatic-Life Safety decisions is a local problem. 
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Figure 84 - BACnet priorities array. 

 

Example: consider a digital output point which has all priorities set with a NULL 
value. The current output point value is, by the default, equal to INACTIVE (OFF). 
Two “switch on” commands are sent to the point, on priorities 6 and 9. As a result, we 
have the output = ACTIVE (ON). If a "switch off" command is sent to the point on 
priority 7, a priority lower than 6 (highest priority not NULL at the moment), the 
command is registered in the array. However, the output is kept ACTIVE (priority 
value 6). 

If the priority 6 is deactivated by sending a NULL to its array position, the output will 
be defined by the value of priority 7, in other words, INACTIVE. 
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Figure 85 – Example of the BACnet priority array operation. 

 

 

6.4.8 Sending Commands 

To send a command, select a point from the project tree, and on the Real Time 
menu, click Command. A dialog box will open to set up the command parameters – 
see figure below. 
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Figure 86 – Send command. 

 

On the displayed dialog box, the field Parameter should be filled out with the desired 
BACnet command priority. It must be between 1 and 16. The field Value refers to the 
digital or analog value that will be assigned to the commanded point. To command a 
digital point, send Value = 0 to switch it off or Value = 1 to switch it on.  

To send a NULL value to a point, therefore relinquishing the referred priority array 
position, use Value = 999.  

 

 
Figure 87 – Sending a NULL value. 


